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WARRANTY

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and

workmanship for a period of one (1) year from the date of shipment. If a product proves defective during this

warranty period, Tektronix, at its option, either will repair the defective product without charge for parts and labor,

or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration

of the warranty period and make suitable arrangements for the performance of service. Customer shall be

responsible for packaging and shipping the defective product to the service center designated by Tektronix, with

shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a

location within the country in which the Tektronix service center is located. Customer shall be responsible for

paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate

maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage

resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;

b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any

damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been

modified or integrated with other products when the effect of such modification or integration increases the time

or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS

OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’

RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND

EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.

TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,

INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR

THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Connect and Disconnect Properly. Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Do Not Operate Without Covers. Do not operate this product with metal covers or
panels removed.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

To Avoid Fire or
Personal Injury
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Terms in this Manual. These terms may appear in this manual:

WARNING.Warning statements identify conditions or practices that could result

in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in

damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

CAUTION
Refer to Manual

WARNING
High Voltage

Protective Ground
(Earth) Terminal

Symbols and Terms
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Preface

This is the user manual for the VM5000HD Automatic Video Measurement Set.
This manual focuses on the automatic video measurement functionality; it does
not cover the oscilloscope functionality. Refer to Related Manuals and Online

Documents for where to find information about using the oscilloscope function-
ality.

About This Manual

This manual is composed of the following chapters:

� Getting Started shows you how to configure and install your instrument and
provides a functional check procedure.

� Operating Basics, using a highly-graphical approach, walks you through the
basics of using the instrument user interface.

� Reference goes into more detail on the menu functions, understanding the
measurements, and interpreting your results.

� Appendices provides additional information including instrument specifica-
tions, performance verification, remote command information, cleaning
information, and signal source descriptions.
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Related Manuals and Online Documents

This manual is part of a document set of manuals and online documentation. See
the following list for other documents supporting operation and service.

Manual name Description

VM5000HD Automatic Video Measurement
Set Online Help

An integrated online help system, which can be accessed from the VM5000HD help
menu (located in the middle of the screen when the VM5000HD application is open).

TDS5000 Series Digital Phosphor Oscillo-
scopes User Manual (.pdf file)

A .pdf file of the user manual describing the oscilloscope platform functionality. This
pdf file is located on the VM5000HD product CD, 063-3653-XX.

TDS5000 Series Digital Phosphor Oscillo-
scopes Online Help

An integrated online help system, which can be accessed from the oscilloscope
platform help menu (located at the top right of the screen).

TDS5000 Series Digital Phosphor Oscillo-
scopes Reference Manual

A quick reference to major features of the ocsilloscope platform.

TDS5000 Series OscilloscopeOnline
Programmer Guide

A listing of the programming commands and other information related to controlling the
oscilloscope functionality over GPIB.

TDS5000 Series Digital Phosphor Oscillo-
scopes Service Manual

A description of how to service the instrument to the module level. This optional
manual must be ordered separately.
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Contacting Tektronix

Phone 1-800-833-9200*

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Web site www.tektronix.com

Sales support 1-800-833-9200, select option 1*

Service support 1-800-833-9200, select option 2*

Technical support Email: techsupport@tektronix.com

1-800-833-9200, select option 3*

6:00 a.m. -- 5:00 p.m. Pacific time

* This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix Web site for a list of offices.
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Product Description

This manual supports the VM5000HD Automatic Video Measurement Set.

This chapter summarizes and highlights some of the key features of the
instrument. Following this description are three sections:

� Installation shows you how to configure and install the instrument, as well
as how to reinstall the system software included with the product.

� Incoming Inspection procedure verifies basic operation and functionality.

� Accessories lists the standard and optional accessories for this product.

Key Features

The VM5000HD instrument is a high-performance solution for verification,
debugging, and characterization of analog high-definition video signals. Key
features include:

� Fast, accurate, and repeatable video measurements

� Fully automated, comprehensive component analog video measurements

� Supports HDTV, progressive, and PC-format component analog video
(YPbPr and RGB)

� Acquisition bandwidth & high sample rates for HDTV signals

� Test signal files for convenient test signal generator setup (see page F--1 for a
description of Option SS)

� Powerful automated measurement features and utilities

� Standard GPIB and LAN remote control capability

� MS Windows operating system, an intuitive graphical user interface, and
online help for easy operation with minimal training time

� Video measurement accessories

� Extended documentation capabilities

� Complete oscilloscope functionality

Targeted to meet the needs of video professionals developing, testing, and
manufacturing the next generation of Digital Television reception and play-out
devices, the instrument incorporates the power, features, and functionality
needed in R&D, QA, and Production Test applications. It enables manufacturers
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to ensure that HDTV video signal quality is up to the challenge of today’s high
performance displays, as well as enables clear differentiation between input
signal and display device impairments.

Applications include the following:

� R&D

� Compliance & certification testing

� Quality/audit testing

� Automated production test

� Off-air video systems testing

The VM5000HD automates a variety of component analog video measurements
utilized to verify the integrity and quality of HDTV video signals. It automatical-
ly assesses conformance of selected video signal parameters to applicable
EIA--770--3, SMPTE -- 274M, and 296M standards. It also automates measure-
ment of other industry-standard video parameters that are utilized to quantify the
performance of Digital Set-top boxes or other Consumer video reception and
play-out devices with component analog interfaces.

By integrating automated measurement algorithms and a high-speed, wide
bandwidth signal acquisition platform into one instrument, Tektronix offers a
reliable means to make fast, objective, and accurate video measurements.
Product verification activities that previously took hours or days to complete can
now be completed in seconds or minutes. Offering near plug-and-play video
measurement capability, even unskilled operators can reliably assess HDTV
video output signal quality.

As a fully integrated video analyzer, the VM5000HD offers simple configuration
menu settings that can readily be recalled or copied, eliminating complicated
oscilloscope set-ups, tedious manual measurements, and time-consuming results
correlation exercises. Product quality is enhanced because reliable HDTV test
results can be reliably generated, easily replicated with other VM5000HD
instruments, and readily communicated across a global engineering, supply, or
sales organization.

The VM5000HD offers intuitive Windows based configuration and measurement
results menus for easy operation with minimal training time. A 10.4 in (264 mm)
Color Display provides a bright, clear, and crisp display of waveforms and
measurement results. Users can easily navigate through the logically arranged
configuration and results menus, and make selections via radio buttons or an
on-screen keyboard utilizing the included USB mouse.
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Firmware Upgrade

Tektronix may offer firmware upgrade kits for the VM5000HD instrument.
Contact your Tektronix service representative for more information (see
Contacting Tektronix on page xi).

Recommended Oscilloscope Probes

Table 1--1 lists the recommended oscilloscope probes to use when using the
instrument as an oscilloscope.

Table 1- 1: Recommended probes

Probe type Tektronix probe

Passive, 10X, 500 MHz P5050

Passive, 100X, 250 MHz, high voltage P5100

Passive, 1000K, 100 MHz, high voltage P6015A

Active, DC to 1.0 GHz, FET high speed digital,
for CMOS/TTL technology

P6243

Active, DC to 1.5 GHz, FET high speed digital,
for all technologies

P6245

Active, DC to 400 MHz, FET, high bandwidth differential P6246

Active, DC to 1.0 GHz, FET, high bandwidth differential P6247

Active, DC to 1.7 GHz, FET, high bandwidth differential P6248

Active, 100 MHz, high voltage differential P5205

Active, 50 MHz, high voltage differential P5210

Current, 250 KHz to 2 GHz, 50Ω input, AC Only,
for temporary in-circuit installation

CT-6

Current, DC to 50 MHz, 15 A DC TCP202

Low Capacitance, 20X, 3 GHz P6158
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Installation

This section addresses instrument installation:

� Unpacking on page 1--5

� Checking the Environment Requirements on page 1--6

� Connecting the Mouse on page 1--7

� Powering On the Instrument on page 1--8

� Shutting Down the Instrument on page 1--8

� Creating an Emergency Startup Disk on page 1--9

� Backing Up User Files on page 1--9

� Installing Software on page 1--10

� Connecting to a Network on page 1--11

� Adjusting Display Contrast on page 1--12

CAUTION. Be sure to create your emergency startup disk as described on

page 1--9. You may need that disk if you ever need to reinstall Windows 2000 on

the instrument hard drive.

Unpacking

Refer to the tables beginning on page 1--19 for a list of the options and accesso-
ries shipped with this instrument. Remember to fill out and send in the customer
registration card.
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Checking the Environment Requirements

Read this section before starting any installation procedures. This section
describes site considerations, power requirements, and ground connections for
your instrument.

The instrument is designed to operate on a bench or on a cart in the normal
position (on the bottom feet). For proper cooling, make sure that there is at least
three inches (76.20 mm) of clearance on the left side of the instrument. If you
need to access the instrument CD-RW drive, you will also need at least 5.1
inches (129.54 mm) of clearance on the right side of the instrument.

330.20 mm
(13.00 in)

482.60 mm
(19.00 in)

76.20 mm
(3.00 in)

Figure 1- 1: Instrument space requirements

CAUTION. To ensure proper cooling, keep the bottom and left side of the

instrument clear of obstructions.

The specifications in Appendix A list the power source, temperature, humidity,
and altitude operating requirements for the instrument.

Site Considerations

Operating Requirements
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Connecting the Mouse

The instrument includes a USB (Universal Serial Bus) mouse. You can plug the
mouse into any of the four available USB ports. The USB ports and other PC
peripheral connection points are shown in Figure 1--2. Refer to the TDS5000
Series User Manual .pdf file on the VM5000HD product CD (063-3653-XX) for
additional connection information.

PS/2 mouseKeyboard

Ethernet

Centronics printer

GPIB

Scope VGA output

USB

PC SVGA output

RS-232

Audio line out

Audio line inMicrophone in

USB

Figure 1- 2: Locations of VM5000HD connectors

NOTE. For best performance, plug the USB devices directly into the USB

connectors on the instrument chassis, rather than connecting the devices serially.

You can connect or disconnect USB mouse, keyboard, or other USB devices with

the power on. If your USB mouse locks up, disconnect and reconnect the USB

connector to restore normal operation.

CAUTION. To avoid product damage, shut down the instrument and disconnect

the power cord from the power source before connecting any accessories other

than USB devices. If the instrument front panel and/or touch screen does not

respond, press the On/Standby switch for at least 5 seconds to cycle power.

See Shutting Down the Instrument on page 1--8.
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Powering On the Instrument

Follow these steps to power on the instrument for the first time.

CAUTION. To ensure proper operation, connect the keyboard, mouse, and other

accessories before applying power to the product the first time.

1. Connect one end of the instrument power cord to the instrument and the
other end to a power source.

2. Push the On/Standby switch to power on the instrument (see Figure 1--3 for
the switch location).

On/Standby
switch

Figure 1- 3: On/Standby switch location

Shutting Down the Instrument

To shut down the instrument, push the front-panel On/Standby switch. The
instrument preserves settings and then starts a shutdown process (including a
Windows shutdown) to put the instrument into standby mode. Avoid disconnect-
ing the power cord or power source to shut down the instrument.

NOTE. If you remove power instead of using the On/Standby switch to shut down

the instrument, the instrument will be in the factory Default Setup when powered

on the next time.

If the shutdown process does not start immediately after pushing the ON/Standby

switch, push and hold the On/Standby switch for up to 20 seconds to start the

shutdown process.

To completely remove power to the instrument, push the On/Standby switch and
then disconnect the power cord from the power source.
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Creating an Emergency Startup Disk

Now that you have completed the basic installation process, you should create an
emergency startup disk. The emergency startup disk contains basic files to restart
your instrument in case of a major hardware or software failure. The disk also
contains files that you can use to check and format the hard disk.

CAUTION. Create this disk and store it in a safe place. It may help you recover

your Windows 2000 installation without rebuilding the entire instrument hard

disk.

Follow these steps to create the emergency startup disk for a Windows 2000
instrument:

1. Minimize the instrument application by selecting Minimize in the File
menu.

2. From the Windows taskbar, select Start > Programs > Accessories

>System Tools > Backup.

3. In the Welcome display, click Emergency Repair Disk.

4. Insert a 3.5 in disk into the disk drive, and follow the on-screen instructions
to create the startup disk.

Backing Up User Files

Always back up your user files on a regular basis. Use the Windows Backup tool
to back up files stored on the hard disk. The Backup tool is located in the System
Tools folder in the Accessories folder.

Use these steps to back up your files:

1. Exit the instrument application by selecting the File menu Exit command.

2. Click the Windows Start button.

3. Select Programs > Accessories > System Tools > Backup.

4. Use the Backup Wizard to select the items you want to back up and the
destination. The destination can be the floppy drive or a third-party storage
device over one of the side-panel ports.
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Installing Software

The instrument system and application software is preinstalled at the factory. If
you have to reinstall the software for any reason, refer to the instructions that
accompany the CD-ROMs shipped with the instrument.

Read the software release notes (README.TXT) on the product software
CD-ROM before performing installation procedures. This file contains additional
information that supercedes other product documentation.

To view README.TXT, start the Windows Notepad accessory and open the file
from the VM5000HD Automatic Video Measurement Set Product Software

CD-ROM.

The GPIB programmer information is available in Appendix C.

Programmer information for the rest of the instrument functions is available as a
.pdf file on the TDS5000 Series Product Software CD-ROM (063-3508-XX).

Software Release Notes

VM5000HD Remote
Command Information
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You can install desktop application software on the instrument. The instrument
has been tested with the following software products installed:

� Microsoft Office 98 (Word, Excel, PowerPoint, and so forth)

� MathCad

� MATLAB

Other software products may be compatible but have not been tested by
Tektronix. If the instrument malfunctions after you install software, uninstall the
software and then reinstall the instrument software (if necessary) to restore
proper operation.

Exiting the instrument Application. Before installing other desktop applications,
exit the instrument application. To do this, select the File > Exit command.

Connecting to a Network

You can connect the instrument to a network to enable printing, file sharing,
internet access, and other communications functions. Before you make the
connection, do the following steps to enable network access to the instrument:

1. Begin with the instrument power off.

2. Attach a keyboard and mouse to the instrument.

3. Power on the instrument.

4. As the instrument begins to boot, press the keyboard F2 key repeatedly until
the message “Loading SETUP” appears.

5. In the BIOS Setup Utility, use the keyboard right-arrow key to highlight the
Advanced menu at the top of the screen.

6. Use the arrow down key to highlight Peripheral Configuration in the
Advanced screen, and then press Enter.

7. Use the arrow down key to highlight LAN Device in the Peripheral
Configuration screen, and then press Enter.

8. Use the arrow up or down key to highlight Enabled, and then press Enter.

Desktop Applications
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9. Press the F10 key to save and exit. Confirm the Save of Configuration
changes when you are prompted on screen.

10. Use the Windows network setup utility to define the instrument as a network
client, and configure it for your network. You can find the network setup
utility in the Windows Start menu if you select Settings > Control Panel

and then double click Network. You should consult your network adminis-
trator for specific instructions to make these settings.

NOTE. If you want to disable network access for the instrument, perform the

above procedure, except substitute Disabled for the command listed in step 8.

The instrument will boot faster with network access disabled.

Adjusting Display Contrast

If you find that the instrument screen is too bright or too dark, use these steps to
adjust the LCD display contrast to your preference. You must have a mouse
attached to perform this procedure.

1. Right click with the mouse on the Windows desktop.

2. Select Properties.

3. Select the Settings tab.

4. Click Advanced.

5. Select the Color tab.

6. Adjust slider control for desired gamma setting. The screen brightness will
change as you move the slider control.

7. Click Apply.

8. Click OK.
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Incoming Inspection

This section contains instructions for performing a self test and functional
verification of the instrument. These procedures verify that the instrument is
operating correctly after shipment, but do not check product specifications.

If the instrument fails any test within this section, it may need service. To contact
Tektronix for service, see Contacting Tektronix on page xi of Preface.

Make sure you have put the instrument into service as detailed in Installation

starting on page 1--5.

Self Tests
This procedure uses internal routines to verify that the instrument functions and
was adjusted properly. No test equipment or hookups are required.

Equipment required None

Prerequisites Power on the instrument and allow a 20 minute warm-up.

Perform these substeps to verify internal diagnostics:

1. Display the system diagnostics menu as follows:

a. If the instrument is in the toolbar mode, click Menu (far right toolbar
button) to switch to menu bar mode.

b. From the Utilities menu, select Instrument Diagnostics to open the
Instrument Diagnostics control window.

c. Ensure that ALL is selected from each drop-down list.

2. Run the system diagnostics as follows:

a. Disconnect all input signals from all four channels.

b. Click Run in the Instrument Diagnostics control window.

The internal diagnostics do an exhaustive verification of proper instrument
function, taking five to fifteen minutes. When complete, the resulting status
appears in the diagnostics control window.

3. Verify that no failures are found and reported: The instrument should pass
all tests. If any failures occur, record the failure information and contact your
local Tektronix service personnel for more information.

4. Run the signal path compensation routine as follows:
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a. From the Utilities menu, select Instrument Calibration to open the
Instrument Calibration control window.

b. Click Calibrate to start the routine.

c. Confirm signal path compensation returns passed status: Signal path
compensation may take up to ten minutes to run. Verify that the word
Pass appears in the Status text box.

5. Click Close to exit the Instrument Calibration control window.

Functional Test

This procedure uses the output from a PC VGA video card to test the
VM5000HD application functionality.

Equipment required VM5000HD

Sync Combiner cable assembly, Tektronix part number 012-1664-XX

75Ω precision BNC terminations (3)

BNC “T” connectors (3)

A PC with a CD drive and a video graphics card capable of displaying
an image at 1280 x 1024 at a 60 Hz refresh rate

NOTE. These procedures verify that the application features operate. They do not

verify that they operate within limits. Therefore, when the instructions in these

functional tests call for you to verify that a signal appears on screen “that is

about five divisions in amplitude” or “has a period of about six horizontal

divisions,” and so on, do not interpret the quantities given as limits.

Do not change the front-panel settings unless directed to by the procedure. If you

change front-panel settings, you may obtain invalid results. In this case, redo the

procedure from step 1.

When you are instructed to press a front-panel button or screen button, the

button may already be selected (its label is lighted). If this is the case, it is not

necessary to press the button.
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1. Set the PC monitor display properties by doing the following steps:

a. Power on the PC and its monitor.

b. Position the cursor anywhere in the desktop background area and click
the right mouse button to show the desktop menu.

c. Select Properties to show the Display Properties dialog box.

d. Select the Settings tab to show the display settings fields.

e. Set the Screen Area slider control to 1280 by 1024.

f. Set the color field to True Color (24 bit).

g. Select the Advanced button to open the advanced settings dialog.

h. Select theMonitor tab to display the monitor dialog.

i. Select 60 Hertz in the Refresh Frequency list.

j. Select OK to dismiss the advanced dialog box. Depending on your
Windows settings, the settings are applied immediately or you are
requested to reboot your computer.

k. Select OK to apply the changes or to reboot your system.

l. Select OK to dismiss the Display Properties dialog box.

2. Set the PC to generate the test signal by doing the following steps:

a. Insert the VM5000HD Application Software CD in the PC CD drive.

b. Start the Windows Paint program (Start > Programs > Accessories >

Paint).

c. From within the Paint program, open the file
<cd-drive>: PCMatrix1280X1024P60.bmp.

d. Select View > View Bitmap to display the file as a full-screen image (no
window borders).

3. Disconnect the PCs monitor cable from the PC VGA video card output
connector.

4. Connect the 15-pin connector on the Sync Combiner cable to the PC VGA
video card output connector.
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5. Connect the other end of the Sync Combiner cable to the VM5000HD
instrument inputs as shown.

VM5000HD

PC

CH4CH3CH2CH1

Red
cable

Blue
cable

Green
cable

H/V
Sync

= 75Ω Termination= BNC “T” connector

PC VGA Out
“D” Connector

6. Power on the VM5000HD instrument and wait for it to complete the
power-on process.

7. Select File > Run Application > VM5000HD to display the VM5000HD
application window.

8. In the application window, select File > Recall Default to load the applica-
tion default settings.

9. In the application window, select Configuration > Format to display the
Format view.

10. Select the SXGA/60 button.

11. In the application window, select Configuration > Operation to display the
Operation view.

12. Select the Channel 4 button in the Trigger area.
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13. In the application window, select the Run button to start the application
measurement process.

The instrument begins taking measurements and displays a Color bars
measurement view listing measurement values similar to those shown below.

Your actual measurement values will depend on your VGA output levels. They
will vary from the nominals (700 mV and 0 mV) by about ±50 mV, but you
should observe the pattern shown in the screen capture above.

You have completed the VM5000HD functional verification procedure.
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Options and Accessories

This section lists the product options, standard accessories, and optional
accessories that are available for the instrument.

Options

You can order the options shown in Table 1--2 with the instrument.

Table 1- 2: Instrument options

Hardware 18 Touch-screen interface

Mounting 1R Rackmount kit

Software SS Complete set of test signals (four CDs, two DVDs)

Power cords A0 North America power cord

A1 Universal EURO power cord

A2 United Kingdom power cord

A3 Australia power cord

A5 Switzerland power cord

AC China power cord

A99 No power cord

Service D1 Calibration data report

C3 Additional two years of calibration

D3 Calibration data report for Option C3

R3 Additional two years of repair

C5 Additional four years of calibration

D5 Calibration data report for Option C5

R5 Additional four years of repair

Accessories

This section lists the standard and optional accessories available. The accessories
listed in Table 1--3 are shipped standard with the instrument.
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Table 1- 3: Standard accessories

Accessory Part number

VM5000HD Automatic Video Measurement Set User Manual 071-1252-XX

TDS5000 Series Digital Phosphor Oscilloscopes Reference

English

French

German

Italian

Spanish

Portuguese

Japanese

Korean

Simplified Chinese

Traditional Chinese

020-2398-XX

Oscilloscope Analysis and Connectivity Made Easy manual with software 020-2449-XX

VM5000HD Product Software CD-ROM (includes VM5000HD product soft-
ware, VM5000HD online help, VM5000HD user manual PDF, TDS5000 user
manual PDF, and release notes)

063-3653-XX

TDS5000 Series Product Software CD-ROM (includes TDS5000 product soft-
ware, TDS5000 online help, VM5000HD Online Programmer Guide (GPIB
online help and PDF), Performance Verification PDF, release notes, VISA
information)

063-3508-XX

TDS5000 Series OS Restore CD-ROM 063-3509-XX

Calibration Certificate documenting NIST traceability, Z540-1 compliance, and
ISO9001 registration

— —

U.S. power cord 161-0104-00

Mouse 119-6298-XX

USB keyboard 119-6633-XX

Front cover 200-4651-XX

Blank CDR / CDRW 020-2434-XX

Click’N Burn CD 063-3575-XX

75 Ohm terminations (3) 011-0102-XX

BNC “T” connectors (3) 103-0030-XX

VGA Sync Combiner cable 012-1664-XX

The accessories in Table 1--4 were orderable for use with the instrument at the
time this manual was published. Consult a current Tektronix catalog for
additions, changes, and details.
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Table 1- 4: Optional accessories

Accessory Part number

TDS5000 Series Digital Phosphor Oscilloscopes Service Manual 071-1004-XX

K420 Scope Cart with mouse accessory tray 436-0317-XX

Transit case 016-1522-XX

TDS5000 Series, VM5000HD rackmount kit 016-1887-XX

Video display clamp 013-0278-00

P5050 500 MHz 10x passive probe P5050

GPIB cable (3.3 ft, or 1 m) 012-0991-01

GPIB cable (6.6 ft, or 2 m) 012-0991-00

Centronics cable 012-1214-00
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Operating Basics

This section provides basic information about using the VM5000HD. More
detailed measurement information can be found in the Reference section.

Input Signal Connection Requirements

Use only 75 Ω coaxial cables to connect the video device under test to the
VM5000HD instrument.

Install the included 75 Ω terminations between the end of the coaxial cables and
the instrument input channels, using the included BNC “T” connectors. For
accurate frequency response measurements, it is important to attach the “T”
connector directly to the VM5000HD input channel BNCs.

75Ω Coaxial
cable

Direct connection to VM5000HD
input channel BNC

BNC “T” connector
(103-0030-00)

75Ω Precision
end-line termination

(011-0102-03)
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Connecting Input Signals

Use the following diagrams to determine the optimum input signal setup for your
measurement needs.

Use this setup for testing 3-wire component analog video signals (Y/G, Pb/B,
Pr/R) with the composite sync signal on Y/G, triggering the instrument on
channel 1 (the default trigger setting). This setup provides the most accurate
frequency response information, but limits noise measurement on Y/G to --65 dB
(30 MHz noise bandwidth).

VM5000HD

Signal source
(Tektronix MTX100)

Modulator

CH4CH3CH2CH1

Y/G

Set top box

Y/G Pb/B Pr/R

Pb/B Pr/R

= 75Ω Termination= BNC “T” connector

3-Wire Video with
Composite Sync, Setup 1
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Use this setup for testing 3-wire component analog video signals (Y/G, Pb/B,
Pr/R) with the composite sync signal on Y/G, triggering the instrument on
channel 4. This configuration provides more accurate low-level (below --60 dB at
30 MHz bandwidth) noise measurements than setup 1. Frequency response
measurements on the Y/G will be degraded by approximately 0.04 dB (0.5%) at
30 MHz due to the additional loading from the CH4 input.

BNC “T”
connector

VM5000HD

Signal source
(Tektronix MTX100)

Modulator

Set top box

Y/G Pb/B Pr/R

= 75Ω Termination

75Ω
Cable

CH4CH3CH2CH1

Y/G

Pr/R

Pb/B

= BNC “T” connector

NOTE. Be sure to set the trigger channel to channel 4; the default trigger

channel is channel 1. If you do not change the trigger setting (Configuration >

Operation), you will see signal warning messages and be unable to take

measurements.

3-Wire Video with
Composite Sync, Setup 2
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Use this setup for testing 4-wire component analog video signals (Y/G, Pb/B,
Pr/R) with the composite sync signal on a separate output line. For CH4,
termination is optional. For CH4 only, you can use no termination or a 75 Ω

termination of lower accuracy than the 75 Ω terminations that are provided with
the instrument.

VM5000HD

Signal source
(Tektronix MTX100)

Modulator

Video device
under test (DUT)

Y/G
CH4

Pb/B Pr/R Sync
CH3CH2CH1

Y/G Pb/B Pr/R Sync

= 75Ω Termination= BNC “T” connector

NOTE. Be sure to set the trigger channel to channel 4; the default trigger

channel is channel 1. If you do not change the trigger setting (Configuration >

Operation), you will see signal warning messages and be unable to take

measurements.

4-Wire Video with
Separate Composite Sync
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Use this setup for testing 3-wire component analog video signals (Y/G, Pb/B,
Pr/R) without the composite signal on Y/G, and triggering the instrument on
channel 4. Use the special VGA sync combiner cable to connect the PC video
card to the instrument. (Use this setup for the Functional Tests beginning on
page 1--14.)

VM5000HD

PC

CH4CH3CH2CH1

Red
cable

Blue
cable

Green
cable

H/V
Sync

= 75Ω Termination= BNC “T” connector

PC VGA Out
“D” connector

NOTE. Be sure to set the trigger channel to channel 4; the default trigger

channel is channel 1. If you do not change the trigger setting (Configuration >

Operation), you will see signal warning messages and be unable to take

measurements.

VGA PC Video Card Signal
Measurement Setup
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The Matrix Test Signal

The Matrix test signal, shown below, is provided with Option SS. It incorporates
all analog HD video signal requirements into different line numbers within one
test pattern field. Using a single test pattern eliminates the need to change test
signals when doing different measurements. All you need to change is line
numbers. Use the setup file (.vmset) that matches the format of the Matrix test
signal you are using; this provides appropriate line numbers as default settings
for each measurement type. See page F--1 for a full description of the Option SS
files.

1

2

3

4

5

6

7

8

9

10

11

12

13

14

Signal Format Signal Format Signal Format

1. Color bars All 6. Sweep YPbPr 11. Valid ramp All

2. Sweep RGB 7. 30 MHz MB YPbPr 12. Flat field: 0% black All

3. Sweep RGB 8. 15 MHz MB YPbPr 13. Flat field: 50% grey All

4. Multiburst RGB 9. Windowed sweep RGB 14. Flat field: 100% white All

5. Sweep YPbPr 10. Windowed sweep YPbPr
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Starting the Application

Make sure you have set up the input signal sources before taking measurements (see page 2--9).

1. Power on the instrument. The

instrument displays the default

main screen.

1

2. In the menu bar, select File >

Run Application >

VM5000HD.

The instrument reduces the

waveform area to the upper half

of the display, and opens the

VM5000HD application in the

lower half of the display.

2
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The VM5000HD Application User Interface

1. Menu bar: Selects setting con-

trols and results information to

display in the Application view.

2. Application view: Displays

configuration controls and mea-

surement results.

2

1

3. Run Button: Sets up, starts tak-

ing measurements, and displays

results.

4. Stop button: Halts the measure-

ments.

3

6 5

4

5

5. Hide button: Restores the main display to full-screen and hides the application window behind

the main display.

To restore the application window after hiding it, select the App button on the main display.

To access the MS Windows desktop (for viewing reports), select Hide. In the main display, select

File > Minimize, and then select the application Hide button again.

6. Exit button: Exits (closes) the application and returns the instrument to the default main display.



Operating Basics

VM5000HD Automatic Video Measurement Set User Manual 2- 9

Measurement Steps Overview

1. Set the input signal format standard (such as 1080i/60) and color space (Y Pb Pr or RGB) by us-

ing the Configuration > Format menu (page 2--9).

2. Select one or more measurements to take by using the Configuration > Measurements menu

(page 2--10).

3. Set the measurement run operations, such as run mode and trigger channel, by using the Config-

uration > Operation menu (page 2--11).

4. Select the Run button to take and view measurements (page 2--13).

5. Save measurement results by using the Utilities > Generate Reports menu (page 2--17).

Setting the Input Signal Format

1. Select

Configuration > Format.

The application opens the For-

mat view.

1

2. Select the appropriate video for-

mat for the signal you are mea-

suring.

3. Select the appropriate color

space type for the signal you are

measuring.

2

3
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Selecting Measurements

1. Select

Configuration > Measure-

ments.
1

2. Select from one to six measure-

ments, in any combination.

2
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Setting the Measurement Run Operations

1. Select

Configuration > Operation.

The instrument displays the Op-

eration view. These settings

control how the instrument sets

up and acquires measurements

when you select the Run button.

1

2. Select how the instrument sets

up and runs measurements.

2

� Setup & Run configures the instrument settings and takes a measurement, for each selected
measurement, and for each measurement acquisition. Use this when taking multiple measure-
ments that require different instrument setups.

� Setup Only configures the instrument for a measurement but does not take the measurement.
Use this to set up customized settings. Try out your settings by pressing the Run button, make
adjustments as needed (for example, change the horizontal scale), and then select the Run
button again. Once you are satisfied with your customizations, use the Run Only setting to
collect results.

� Run Only takes a measurement using the existing instrument configuration. Designed for
taking measurements with custom settings (see Setup Only description above).
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3. Select how the application ac-

quires measurements (run

mode). 3

� Continuously continually takes measurements. You must select the Stop button to stop
measurements.

� Once takes each selected measurement the number of times determined by the averaging
setting, then stops taking measurements.

4. Enable or disable waveform au-

toscaling. Auto Scaling adjusts

the vertical scale units so that

the input signals fill the grati-

cule as much as possible. Auto

Scaling occurs once for each se-

lected measurement.

Refer to page 3--7 for details.

4

5. Select which instrument chan-

nel has the sync signal for trig-

gering.

If you use the wrong trigger

channel (and Signal Warnings is

on), you will get a signal warn-

ing. See the setup diagrams and

trigger requirements on

page 2--2.

5

6. Select which warning messages

to display.

See page 3--7 for more informa-

tion.
6
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Taking and Viewing Measurements

Make sure you have selected a signal format, selected one or more measurements, and configured the run
options before taking a measurement.

1. Select the Run button.

The instrument begins taking

measurements and displays the

measurement results view for

the most recently-selected mea-

surement result.

1

2. To view the results for other

measurements, select the mea-

surement from the Results

menu. For example, to view the

Sync measurement results, se-

lect Results > Sync.

The instrument displays the se-

lected measurement results. You

can only display results for

measurements that are selected

in the Format > Measurements

view.

2

3. If you set the run operation to

Continuously, press the Stop

button to stop taking measure-

ments.

3
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Changing Line Number or Averaging on the Results Screen

1. Select a measurement from the

Results menu. For example, se-

lect Results > Sync.

The instrument displays the se-

lected measurement results.

1

2. You can change the video signal

line number and the number of

measurements to average before

displaying results. The instru-

ment stops measuring, changes

results to dashes, and uses the

new settings at the start of its

next measurement cycle. Refer

to page 3--8 for information on

line numbers and averaging.

To change a value, select the

field and enter a value by key-

board. You can also change val-

ues using one of these methods:

3. Select the keypad icon to the

left of the field to display a

virtual keyboard to enter values

using the touch screen.

4. Use the indicated general pur-

pose knob to change the value.

2

3

3

4
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Saving Measurement Setups

1. Select File > Save.

The application displays the

Save dialog. The default save

location is C:\VM5000HD.

1

2. Select the Look In list to navi-

gate to a different directory oth-

er than the default save loca-

tion.

2

3. Enter a file name in the File

Name field. The instrument of-

fers an available file name (or

you can choose your own). It

automatically appends .vmset to

the file name of measurement

setup files.

4. Select Save to save the mea-

surement settings to the speci-

fied location and file name.

3 4
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Recalling Measurement Settings

1. Select File > Recall.

The application displays the Re-

call dialog and lists all instru-

ment setting files that are pres-

ent in the default

C:\VM5000HD directory.

1

2. Select the Look In: button to

navigate to a different directory

other than the default location

(if desired).

3. Select a file from those listed.

2

3

4. Enter a file name in the File

name: field or select a file from

the list.

5. Select Open to load the settings

file and configure the instru-

ment.

4 5
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Saving Measurement Results (Reports)

You can use the Generate Report function to save your measurement results.

1. Select

Utilities > Generate Report.

The instrument displays the

Utilities Report Generator view.

1

2. Select a report format. Which

format to select depends on

what you want to do with the

measurement results. 2

� RTF: Use RTF (Rich Text Format) to create results data that you can incorporate into
documents.

� PDF: Use PDF (Portable Document Format) to create PDF files of the measurement data for
distribution and viewing. PDF is especially useful for ensuring that the results cannot be
altered.

� CSV: Use CSV (Comma-Separated Values) to create results data that you can insert into
spreadsheets or math software in which you can create limits to verify that your results are
within expected range.

3. Use the File Name field to spec-

ify where you want to save the

report. Use the Browse button

to navigate to a specific loca-

tion. Use the Get Default button

to reset the file name to the de-

fault location and name for the

selected format.

3
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4. Use the Additional Information

field to add notes into the report

file. You can enter up to 46

characters. For example: “Serial

Number 123456789012 tested

by J. Smith”

4

5. Use the Measurements buttons

to select which mesurements to

save to a report.
5

� All: Creates a report with all the measurements you have run since starting the application
which have valid results in the results panels.

� Selected: Creates a report with only the measurements that are currently selected in the
Configuration> Measurements screen and that have valid results in the results panels.

6. Select Generate Report to save

the measurement results to the

specified format and location.

All selected measurements are

saved together in a single file;

each measurement has its own

area in the report.

6
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Reference Overview

This chapter provides a detailed description of the VM5000HD instrument
menus and measurements.

� Menu descriptions. The table below lists the top level of the instrument
menus and the sections in this chapter that document those menus. The menu
descriptions include high-level descriptions of the six measurements.

� Measurement details. Refer to page 3--13 for an in-depth description of each
of the six measurements.

Overview of menu descriptions

Menu Submenu Function Page

File Recall Default Restores default application measurement settings 3--3

Recall Recalls (loads) saved application measurement setups

Save Saves (writes) saved application measurement setups

Minimize Minimizes the application to the Windows task bar

Configuration Format Sets the input signal format 3--5

Measurements Selects measurements to take

Operation Sets measurement runtime options

Results Channel Delay, Color Bars, Multiburst,
Noise, Non Linearity, Sync

Displays the selected measurement results
Adjusts individual measurement settings

3--8

Utilities Generate Report Saves measurement results to specified file format 3--11

Help Help Topics Opens the VM5000HD online help system 3--12

About VM5000HD Displays the application version number
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Menu Descriptions

The following tables list each menu item and its functions. Items in bold face

are the default application settings when first starting the application or after
doing a Recall Default operation.

The File Menu

Recalling a setup file changes the configuration; current measurements will stop
and results appear as dashes.

NOTE. To avoid losing unsaved measurement results, generate a report before

recalling the default setup or another .vmset setup file.

Menu item Function Setting or field Description

Recall Default Recalls (loads) and applies the default application measurement settings.

Recall Recalls (loads) and applies application measurement settings
from the specified file.

Look in Drop-down menu
VM5000HD

Sets the directory to list in the File list area.

File list area Filename list field Lists directories (folders) and setup files that are in the current
directory (as set by Look in).

File name Text entry field Field in which to enter an application setup file to load and apply.
You can also double-click on a file name in the File list area to
enter the name in the FIle Name field.

Files of Type Drop-down menu
.vmset

Lists the valid setup file types. The only valid entry is .vmset.
To get valid test results, be sure to choose the appropriate setup
file for the signal source you are using. For example, for the
Option SS Matrix signal source file Tek1080iMatrix.trp, be sure to
use the Tek1080iMatrix.vmset setup file. The correct .vmset setup
file will have the correct line numbers for each measurement as
the defaults.

Open Loads and applies the specified instrument setting file.

Cancel Closes (exits) the Recall dialog and does not load or apply any
settings.

Save Saves (writes) the current application measurement settings to the specified file name and directory.

All of the Save dialog functions are the same as those for the Recall dialog except for the Save button.
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Menu item DescriptionSetting or fieldFunction

Save Saves the application measurement settings to the specified file
directory (as set by Look in) and file name (as entered in the File
name field) as file type .vmset.

Minimize Minimizes the application to the Windows task bar.
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The Configuration Menu

All the selected measurement results will appear as dashes any time you change
any the following configurations:

� Format

� Color Space

� Trigger

If you change a configuration while running a measurement or a setup, the
measurement or setup will stop.

Recalling a setup file changes the configuration; current measurements will stop
and results appear as dashes.

NOTE. To avoid losing unsaved measurement results, generate a report before

changing any configuration parameters other than selecting measurements or

turning warnings on or off.

Menu item Function Setting or field Description

Format Sets the video input signal format. The Format setting also affects other measurement settings, such as the video
signal line number to use when taking measurements.

Format 480P / 60
576P / 50
720P / 60
1080I / 60
1080I / 50
SXGA / 60

Sets the input signal format.

Color Space YPbPr
RGB

Sets the input signal color space type.

Measurements Selects the video signal measurements to take. You can select from one to six measurements, in any combination.

Measurements Channel Delay
Color Bars
Multiburst
Noise
Non Linearity
Sync

Selects from one to six measurements, in any combination.
When you click the Run button, the selected measurements will
be taken. The results of the measurements you select here will
be included in any report you generate, if you select Utilities >
Generate Report and then set Measurements to Selected.

For a detailed discussion of measurements, refer to page 3--13.
For a high-level overview of measurements, refer to page 3--8.
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Menu item DescriptionSetting or fieldFunction

Operation Sets the measurement runtime options, including test run mode, input trigger channel, and warning message
display.

Setup And/Or
Run

Setup & Run Automatically configures the instrument settings and takes a
measurement, for each selected measurement, and for each
measurement acquisition. Use this when taking multiple
measurements that require different instrument setups.

Setup Only Configures the instrument for a measurement but does not take
the measurement. Use this to set up customized settings.
Customized settings might include changes to the instrument
Horizontal or Vertical front panel controls to display and measure
a non-supported video signal standard.

Try out your settings by pressing the Run button, make
adjustments as needed (for example, change the horizontal
scale), and then select the Run button again. Once you are
satisfied with your customizations, use the Run Only setting to
collect results.

Run Only Run Only Uses the current instrument and application settings to
take a measurement. Use this for taking measurements after
setting up the instrument using Setup Only to create custom
settings.
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Menu item DescriptionSetting or fieldFunction

Run Mode Continuously Continuously continually takes measurements, in the order the
measurements are listed in the Configuration > Measurements
view. You select the Stop button to stop measurements.

Once Takes each selected measurement the number of times required
for the averaging you have selected, and then stops taking
measurements.

Auto Scale On
Off

Enables or disables waveform Auto Scaling. Auto Scaling adjusts
the vertical scale units so that the input signals fill the entire
graticule as much as possible without going out of range. Auto
Scaling occurs once for each selected measurement.

If you are doing only one type of measurement and change the
amplitude of the signal, you may need to auto-scale again: set
Auto Scale to Off and then to On again. If you don’t re-auto-scale
in this way, then you might get bad results, inefficient use of the
dynamic range, or your signal may be out of range.

If you are using custom instrument settings (for example,
changes to Vertical or Horizontal settings made from the
instrument front panel or from remote GPIB commands), you
should turn Auto Scaling Off.

If you are sure your signal is set up correctly and you want to
make further measurements in a high speed production line, set
Auto Scale to Off.

Trigger Channel 1
Channel 4

Sets the input channel on which to trigger the instrument. Refer
to the setup illustrations starting on page 2--2 for appropriate
trigger channel settings.

Warning
Reporting

Measurement Warnings
Signal Warnings
Results Warnings

Sets which warning messages to display on the instrument
screen while taking measurements. All warning messages are
enabled by default. Clear a warning message check box to
disable displaying warning messages.

Measurement warnings include the most general information
about potential problems in making the measurement. Signal
warnings appear if signals are absent or change. If there are
some valid results, Results warnings let you know if some of the
displayed results may not be valid. A Results warning message
box also tells you which types of test results are included in a
report you have just generated.

If warnings are selected, message boxes may appear on screen,
requiring you to click OK. To avoid interruptions to your testing,
disable all of the Warning reporting, especially if you are using
the GPIB interface.
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The Results Menu

If you change the Line Number or Average values for any measurement, or if
you change the Filter configuration in the Noise measurement, then that the
changed measurement will stop running and its results will change to dashes.

All the selected measurement results will appear as dashes any time you change
any the following configurations:

� Format

� Color Space

� Trigger

If you change a configuration while running a measurement or a setup, the
measurement or setup will stop.

The Average setting interacts with your choices for the Run Mode. For example,
if you select Once for the Run Mode and you set the averages to 2, then when
you select the Run button, each selected measurement will run twice and then
stop. On the other hand, if you select Continuously for the Run Mode and 2
averages, then when you select the Run button, each selected measurement will
run twice, display results, and then continue running and updating the results for
every two measurements.

If you are using Option SS Matrix signal source files, be sure to use the
appropriate matching .vmset setup file, if necessary, to get the correct default
values for Line Number for each measurement. See page F--1 for more informa-
tion about Option SS files.

For a detailed discussion of measurements, refer to page 3--13.

Menu item Function Setting or field Description

Channel Delay Measures the time variation between the three video channels. The instrument measures the crossings of all three
channels.

Channel Delay
Measurement
Setup

Line Number Sets the video signal line number to measure. The default value
depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.

Average: 1 Sets the number of acquisitions over which to calculate an
average measurement value.

Results (ns) Displays the time variation, in nanoseconds, from channel 1 to
channel 2, from channel 2 to channel 3, and from channel 3 to
channel 1.

Color Bars Measures all eight color levels of the three video channels. The instrument locates and measures the back porch
signal of each channel, and then measures each channel’s color values relative to that channel’s back porch level.
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Menu item DescriptionSetting or fieldFunction

Color Bar Mea-
surement Setup

Line Number Sets the video signal line number to measure. The default value
depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.

Average: 1 Sets the number of measurements acquisitions over which to
calculate an average measurement value.

Results (mV) Displays eight color values, in mV, for each channel (24
measurements total).

Multiburst Measures the video channel frequency response and amplitude. The instrument measures the flag pulse on each
channel to determine and measure the six burst frequencies with the largest amplitude.

Channel Delay
Measurement
Setup

Line Number Sets the video signal line number to measure. The default value
depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.

Average: 1 Sets the number of measurements acquisitions over which to
calculate an average measurement value.

Multiburst Mea-
surement Results

Displays the flag signal value (in mV) for each channel in the first
display row. The following six rows list the frequency (in MHz)
and amplitude (in dB) of each channel, for each of the six burst
signals.
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Menu item DescriptionSetting or fieldFunction

Noise Measures video signal noise using one of three filter settings.

Noise Measure-
ment Setup

Line Number Sets the video signal line number to measure. The default value
depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.

Average: 1 Sets the number of measurements acquisitions over which to
calculate an average measurement value.

Filter Off Disables (turns off) all noise signal filtering. Use this setting to
measure broadband noise without any filtering.

Unified Weighting Enables (turns on) unified weighting noise signal filtering. Use
this setting to measure noise with the psychovisual weighting
established by CCIR Recommendation (Rec) 576--2, adjusted for
the selected video format.

Unweighted w/
Bandwidth

Enables (turns on) unweighted noise signal filtering and activates
the filter bandwidth field. Use this setting to remove high
frequency noise from your signal.

Bandwidth Hz Sets the bandwidth filter cutoff frequency. Selecting Unweighted
activates this field. The default value depends on the input signal
format as set by Configuration > Format.

Results Displays the noise measurement results for each channel in dB
(relative to peak white) and mV.

Non Linearity Measures channel signal linearity based on a ramp or five-step linearity test signal. If using a ramp signal, the
instrument divides the ramp signal into five values to determine the equivalent step values. The instrument then
measures the bottom, individual step, and top values of the test signal, and compares these values to a nominal
value to determine the percent of deviation of the test signal from the nominal signal.

Non Linearity
Measurement
Setup

Line Number Sets the video signal line number to measure. The default value
depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.

Average: 16 Sets the number of measurements acquisitions over which to
calculate an average measurement value.

Results (%) Displays the percent of deviation of the test signal from a nominal
signal value, as a percentage, for each step on each channel.

Sync Measures the sync signal timing and voltage values. The instrument measures the sync signal rise and fall times
(at the 10% and 90% signal amplitude levels) and the sync pulse width (at the 50% signal amplitude level) to
determine the signal timing values.

Sync Measure-
ment Setup

Line Number Sets the video signal line number to measure. The default value
depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.

Average: 1 Sets the number of measurements acquisitions to take and then
calculate the average measurement value.

Tri-Level Sync
Results

Displays the sync signal timing values in ns, and the signal levels
in mV.
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The Utilities Menu

NOTE. To avoid losing unsaved measurement results, generate a report before

recalling a .vmset setup file or changing any configuration parameters other

than selecting measurements or turning warnings on or off.

Menu item Function Setting or field Description

Generate Report Save (write) measurement results in three popular data formats.

Format RTF Use RTF (Rich Text Format) to create results data that you can
incorporate into documents.

PDF Use PDF (Portable Document Format) to create PDF files of the
measurement data for distribution and viewing.

CSV Use CSV (Comma-Separated Values) to create results data that
you can insert into spreadsheets or math software.

File Name Text entry field
C:\VM5000HD\Tek0.rtf

Field in which to enter the report file name.

Browse Selects the location to which to write (save) the report.

Get Default Sets the report write directory to the default location and name
(C:\VM5000HD\Tek0.rtf).

Additional
Information

Text entry field Adds a brief note into the report file. You can enter up to
46 characters.

Measurements All Creates a report with all the measurements that you have run
since starting the application.

Selected Creates a report with only the measurements that are currently
selected in the Configuration > Measurements screen.

Generation Generate Report Writes the specified measurement data in the selected report
format to the specified location.
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The Help Menu

Menu item Function Setting or field Description

Help Topics Opens the VM5000HD online help window that provides you with application information on your instrument
screen.

About
VM5000HD

Displays a VM5000HD dialog that contains the application software version number.
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Detailed Measurement Information

For a high-level procedure for how to take a measurement, refer to page 2--9.

For a high-level overview of all the measurements, refer to the table beginning
on page 3--8.

The following information applies to all measurements.

Matrix Signals and Line Numbers

The matrix signals provided with Option SS (see page F--1) provide appropriate
signals for all measurements. See the Readme.txt files on the Option SS discs for
extensive information about the files provided.

When using Tektronix supplied matrix test signals, if a .vmset file is provided
for that format of matrix test signal, be sure to use the default line numbers in the
associated .vmset file (File > Recall...). Otherwise, under most circumstances,
use the instrument default line numbers (File > Recall Defaults).

For example, when using the ATSC transport stream file:

Tektronix1080iATSCMatrix.trp,

you should select File > Recall... and then navigate to where you have saved the
setup file:

Tektronix1080iATSCMatrix.vmset.

The line numbers in this setup file may be used for all formats including 1080i,
720p, and 480p in both YPbPr and RGB.

For the equivalent matrix test signal .DNL from a Tektronix TG700 video
generator, use the default settings.

Averaging

The higher the averaging, the lower the variance of the measurement in the
presence of noise or other transient signal components. Set the averaging higher
if you would like to reduce the fluctuations in the measurement results.

The instrument averages results, not input waveforms. (If, on the other hand, the
Noise waveforms were averaged instead of the Noise results, the noise results
would appear lower than they should. Because the instrument averaging results,
this problem is avoided.)
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Measuring Channel Delay

Channel delay measurement is used to verify relative timing of the three
channels of video. Nominal channel delay is zero between all channels.
Deviations from zero correspond to decreased video quality. For example, the
greater the delay between channels, the more likely the edges in video will be
perceived as distorted. Using a narrow band signal, the delay at a particular
frequency band can be measured and thus group delay can be obtained.

In addition, channel delay is a function of relative cable lengths for each of the
channels. Thus, if a splitter is used at the video source output, delay due to cable
length mismatch can be measured.

You can use the matrix signal, or you can use a signal with high cross-correlation
between each pair of channels to be tested. The default signal is the multiburst
signal used for multiburst measurement, but many other types of signals can be
used, including sweeps and even some live program material. If the cross-cor-
relation is high enough for at least one pair of channels, the measurement results
will display. Otherwise, running the measurement will result in “------” for each
channel. If warnings are enabled, low correlation between channels will result in
associated warnings.

A positive number indicates that the first signal arrives later than the second
signal. For example, Y to Pb delay of 4.03 ns means that the signal in the Y
channel is delayed 4.03 ns relative to Pb. However, the signals may contain
distortions, which create different delays for different portions of the video line.
In such a case, the measurement result is the delay compensation required to
maximize the cross-correlation of the second channel with the first, generally
giving a weighted average of the various delays. For narrow band signals, the
delays at a particular frequency band may be measured. An ensemble of such
measurements may be collected to develop a portrait of group delay.

If the signals of the three channels are highly mutually correlated (which is the
case if the signals are reconstructed well and free of distortions other than delay),
the “loop” delay will be approximately zero:

Delay1 -- Delay2 + Delay3 = 0, where

Delay1 is Y to Pb or G to B
Delay2 is Y to Pr or G to R
Delay3 is Pb to Pr or B to R

The more the loop delay deviates from zero, the less the three signals mutually
correlate. High loop delay corresponds to different types of signals among the
three channels, because of differences either in distortions or in the inherent
source signal (as in some live program material, for example). Loop delay
greater than 5ns will generate a warning if warnings are enabled.

Signal Source

Interpreting Results
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The maximum cross-correlation of transitions is found between each pair of
channels. The location of the maximum is the delay in time. Generally, one may
think of the calculation of the delay as the average match of transitions, weighted
by the amplitude of each transition.

How Results are
Calculated
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Measuring Color Bars

Measuring GBR color bars from a set-top-box can be used to verify the correct
colorimetry conversion. Likewise, conversion from 1080i/720p to 480p
colorimetry in YPbPr can be verified. The Color Bars measurement also can be
used to check individual channel gain. In addition, it can be used as a crude
check of linearity since severe clipping or other non-linear distortions will alter
the measurement results from the ideal.

You can use the matrix signal, or you can use a signal with all eight valid color
bars on the line. There is no requirement for the order of the bars except for the
bias that black will be searched after (to the right of) blue. Each of the bars
should be at least 1/24 of the active line time in duration.

The Color Bars measurement measures the amplitude level (relative to back
porch) of each of the 8 colors (white, yellow, cyan, green, magenta, red, blue,
black) for each active channel. Therefore, this measurement makes 8 measure-
ments on 3 channels for 24 total measurements. The software assumes Y is on
Channel 1, Pb is on Channel 2, and Pr is on Channel 3.

NOTE. Some signals intentionally reverse or change the order from the tradition-

al color bar test signal order. Since the bars are measured regardless of order, if

channel inputs are swapped, especially in the case of RGB, the resulting input

will consist of “valid” color levels for all eight bars, but the order will be

incorrect.

First the bars are identified using the relative amplitudes of the three channels
and the specification for the selected format and colorimetry.

The amplitudes are calculated using waveform averaged values within each
identified bar relative to back porch. Thus, it is important to ensure that the sync
signal is within the captured data window for valid measurements. For example,
if a manual set-up is performed, not only are all eight bars required on the
waveform display, but the entire horizontal blanking area to the right of the
signal being measured is also required in order to locate the sync signal and the
associated back porch.

Signal Source

Interpreting Results

How Results are
Calculated
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Measuring Multiburst

The Multiburst measurement is used to verify frequencies and corresponding
amplitudes of sinusoidal bursts. It can be used to verify the proper reconstruction
of a band-limited video signal across the frequency spectrum. For example, a
frequency roll-off (decrease in amplitude with increasing frequency) is seen with
video from an analog-to-digital converter that lacks a reconstruction filter with
sin(x)/x correction. In this example, quality is reduced by things like loss of
detail in the video or color shifts in details.

Deviations in frequency from the reference test signal frequency (for example, a
30 MHz burst is rendered as a 20 MHz burst) may indicate things such as format
change through frequency shift, frequency aliasing due to digital and/or analog
re-sampling, and/or frequency aliasing due to the lack of a proper reconstruction
filter.

The flag amplitude measurement can be used to verify the channel gain across a
wider frequency range than each burst. Burst amplitudes are measured relative to
the flag amplitude.

You can use the matrix signal, or you can use any multiburst signal with a
reference flag preceding the bursts. The more cycles present in each burst, the
more robust and generally more accurate the measurement will be. A burst with
less than 2 cycles is not recommended.

The frequencies are always displayed from lowest to highest regardless of the
order of burst frequencies in the multiburst signal. To avoid confusion regarding
the correspondence between the results burst numbering and the signal burst
ordering, a signal with increasing burst frequencies (from left to right) is
recommended.

For multiburst signals free of non-linear distortion and with increasing burst
frequencies, the “Frq(MHz)” column displays the fundamental frequency of burst
specified in each row. The “Amp(dB)” column has the magnitude of the
corresponding burst.

However, if non-linear distortion is present, interpreting results may be less
straight forward.

In many consumer set-top boxes, lack of a reconstruction filter (with out-of-band
rejection plus sin(x)/x correction) leads to roll-off in the fundamental frequency
component of the bursts even though the envelope of the bursts may be flat on
average. In this case, the amplitude results for the highest frequency may be low
by a few dB even though the waveform shows the same burst with peak-to-peak
amplitude closer to 0 dB. This indicates that the burst is no longer a pure
windowed sinusoid, but has other spectral content (at least one alias frequency in

Signal Source

Interpreting Results
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this example). If the extra spectral content is removed by filtering, the resulting
sinusoid will have the amplitude shown in the results.

Generally, if the signal has undergone processing without a required anti-alias
filter (as in re-sampling for format conversion, or signal reconstruction), each
burst may contain one or several frequency aliases. In such cases, burst
frequencies that increase with each burst of the input signal may contain burst
frequencies in nearly any order in the output of the device under test.

For example, in the 480p rendering of an ATSC 1080i multiburst signal, 5 MHz
is rescaled to 4.85 MHz, 10 MHz to 9.71, but 15 MHz, 20 MHz, 25 MHz, and
30 MHz become any number of frequencies (including 12.44 MHz, 7.58 MHz,
2.73 MHz, and 2.12 MHz respectively). These frequency aliases and respective
amplitudes are measured and displayed in order: 2.12 MHz, 2.73 MHz,
4.85 MHz, 7.58 MHz, 9.71 MHz, 12.44 MHz.

The six largest peaks are found in the spectrum of signal on the pedestal. These
frequencies are displayed in order from lowest to highest. For each of these
frequencies, the maximum magnitude of the cross-correlation between the signal
within the pedestal area and a windowed complex sinusoid is found. This gives
the amplitude.

How Results are
Calculated
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Measuring Noise

The unweighted noise within the nominal bandwidth of the video signal is
measured to ensure that the video quality is not reduced by random errors such
as those that cause “snow.”

You can use the matrix signal, or you can use any flat line or line pedestal signal.

As a rule of thumb, errors generally become visible when the signal-to-noise dB
measurement ranges in the low 40s. However, the degree of visibility depends on
many factors, including spectral distribution of the noise. In standard definition
television, noise weighting filters such as CCIR Recommendation (Rec) 576--2
unified weighting filter are used to weight the noise spectrum to better match the
visibility of noise in typical viewing conditions. The unified weighting filter has
been modified to exactly match the “visibility of noise characteristics” of 576--2
on the screen for each selected video format.

After line tilt and other low frequency distortions are removed from the signal,
all AC signal content is spectrally weighted by the selected filter, if any, and the
resulting RMS voltage is calculated along with the signal-to-noise ratio in dB
using a 700mV peak signal value.

Signal Source

Interpreting Results

How Results are
Calculated
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Measuring Non Linearity

This measurement is used to measure deviations from a straight line ramp test
signal. Deviations can be caused by such things as soft-limiting from analog
amplifiers and digital processing errors. Problems in linearity can reduce video
quality by, for example, reducing contrast at various average luminance levels,
creating color shifts.

You can use the matrix signal, or you can use either a ramp or step signal.
However, a ramp signal will give the best accuracy.

The measurement shows deviations from linear increase in the test signal as a
percentage of the largest increase per time found.

In the case of steps, results are deviations in step amplitudes in the test signal as
a percentage of the largest step found.

In the case of ramps, using six equal time intervals across the ramp, results are
deviations from linear increase in the test signal as a percentage of the largest
increase per time found.

Signal Source

Interpret ing Results

How Results are
Calculated
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Measuring Sync

This measurement is used to check synchronization signal timing and amplitude,
including the relative position of the start and end of active video (interpreted by
looking at front and back porch times).

You can use the matrix signal, or you can use a signal with signal amplitude
greater than 7.5% at the beginning and end of active video in order to measure
front porch and back porch times.

The amplitudes are measured relative to back porch.

Selecting either 1080 or 720 formats will display the tri-level sync results.
Selecting either 480, 576, or SXGA will display the bi-level sync results.

The amplitudes are measured relative to back porch.

The times are taken as the time between half amplitudes of adjacent transitions.
For example, “Neg. Sync Width” is the measured time between the half
amplitude of the falling or leading edge of negative sync and the half amplitude
of the rising or trailing edge of negative sync.

In the absence of sufficiently large (greater than 7.5%) video signal, the width of
front porch and back porch may not be found. In this case, the measurement of
the respective porch widths will not be valid.

Signal Source

InterpretResults

How Results are
Calculated
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Appendix A: Specifications

All specifications are guaranteed unless labeled “typical.” Typical specifications
are provided for your convenience but are not guaranteed.

� The instrument must have been calibrated in an ambient temperature
between 20 °C and 30 °C (68 °F and 86 °F).

� The instrument must be operating within the environmental limits listed in
Table A--10 on page A--15.

� The instrument must be powered from a source that meets the specifications
listed in Table A--8 on page A--14.

� The instrument must have been operating continuously for at least 20
minutes within the specified operating temperature range.

� You must perform the Signal Path Compensation procedure after the
20-minute warm-up period. If the ambient temperature changes more than
5 °C (10 °F) you must restart the procedure. In the TDS5000 user manual,
see the appendix Optimizing Measurement Accuracy for instructions to
perform this procedure.

Table A- 1: Video measurement specifications

Characteristic Description

Color bar measurement accuracy ±2.0 mV ±1.5 V%
of reading

Measurement of all 8 bar
levels, displayed in abso-
lute (mV) values. YPbPr or
RGB formats.

Noise measurement Range and Accuracy

Unweighted --20 to --60 dB, ±1 dB
(30 MHz measurement
bandwidth)

Noise measurement band-
width selectable, 200 KHz
to 250 MHz. Trigger on
CH 4 i d f

--60 to --70 dB, ±2 dB
(30 MHz measurement
bandwidth)

gg
CH 4 required for measure-
ments below --60 dB
(30 MHz BW).

Weighted --20 to --60 dB, ±2 dB Unified Weighting Filter.
Trigger on CH 4 required
for measurements below
--60 dB.

Noise floor Less than --76 dB, 30 MHz
noise bandwidth

Typical is less than --80 dB,
30 MHz noise bandwidth
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Table A- 1: Video measurement specifications (Cont.)

Characteristic Description

Multiburst measurement Accuracy

Flag amplitude ±2mV ±1.5% of reading

1 MHZ to 10 MHz packets ±0.5 dB Measurement relative to
f fl lit d

10 MHZ to 30 MHz packets ±0.75 dB
reference flag amplitude

Frequency readout Multiburst packet frequency
is measured and displayed.

Non-linearity measurement
accuracy

1.5% Non-linearity measurement
using a ramp test signal.
Incremental linearity re-
ported over five equally
spaced intervals, as well as
an overall linearity figure for
each channel.

Sync measurement Accuracy

Sync amplitude ±2mV ±1.5% of reading Blanking interval measure-
t i l di

Sync timing ±5 ns
ments, including sync am-
plitude, width, and rise

Rise and Fall time ±5 ns
plitude, width, and rise
time.

Channel delay CH 1 to CH 2, CH 1 to CH 3, CH 2 to CH 3;
readouts in ns.

Range Accuracy

Measurement ±35 ns ±5 ns

Delay match error Less than 1 ns Any two channels

Table A- 2: Channel input and vertical specifications

Characteristic Description

Input coupling DC, AC, and GND

Input channels Four, all identical

Input impedance, DC coupled 1 MΩ ± 1.0% in parallel with 18 pF ±2 pF
50Ω ±2.5%;
VSWR ≤ 1.5:1 from DC to 1 GHz

Maximum voltage at input BNC
(1 MΩ)

150 VRMS CAT I, and ≤ 400 peak

For steady state sinusoidal waveforms, derate at
20 dB/decade above 200 kHz to 9 VRMS at 3 MHz and
above.

Maximum voltage at input BNC
(50Ω)

5 VRMS, ±30 V peak



Appendix A: Specifications

VM5000HD Automatic Video Measurement Set User Manual A- 3

Table A- 2: Channel input and vertical specifications (Cont.)

Characteristic Description

Differential delay at input BNC ≤ 100 ps between any two channels with the same scale
and coupling settings

Deskew range, typical ±75 ns

Channel-to-channel crosstalk ≥ 100:1 at 100 MHz, and ≥ 30:1 at the rated bandwidth
for any two channels with the same scale and coupling
settings

Digitizers 8-bit resolution, separate digitizers for each channel
sample simultaneously

Sensitivity range 1 MΩ: 1 mV/div to 10 V/div, in a 1-2-5 sequence

50 Ω: 1 mV/div to 1 V/div, in a 1-2-5 sequence

Fine adjustment available with ≤1% resolution

Analog bandwidth DC 50Ω coupling, bandwidth limit set to Full, operating
ambient ≤30 °C, derated by 2.5 MHz/°C above 30 °C

SCALE range Bandwidth

1 mV/div to 1.99 mV/div DC to 175 MHz

2 mV/div to 1 V/div DC to 1 GHz

Analog bandwidth limit, typical Selectable between 20 MHz, 150 MHz, or Full

Lower frequency limit, AC coupled < 10 Hz for 1 MΩ, reduced by a factor of ten when using
a 10X probe; <200 kHz for 50Ω

Calculated rise time, typical DC 50Ω coupling, bandwidth limit set to Full

SCALE range Rise time

1 mV/div to 1.99 mV/div 2.29 ns

2 mV/div to 1 V/div 300 ps

Step response settling errors,
t i l

Bandwidth limit set to Full
typical

SCALE range and step
amplitude

Settling error at time after
step

1 mV/div to 99.5 mV/div,
with ≤ 2 V step

20 ns: ≤ 0.5%

100 ns: ≤ 0.2%

20 ms: ≤ 0.1%

100 mV/div to 1 V/div,
with ≤ 20 V step

20 ns: ≤ 1.0%

100 ns: ≤ 0.5%

20 ms: ≤ 0.2%

1.01 V/div to 10 V/div,
with ≤ 200 V step

20 ns: ≤ 1.0%

100 ns: ≤ 0.5%

20 ms: ≤ 0.2%
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Table A- 2: Channel input and vertical specifications (Cont.)

Characteristic Description

Position range ± 5 divisions

Offset range 1 M Ω coupling

SCALE range Offset range

1 mV/div to 99.5 mV/div ±1 V

100 mV/div to 1V/div ±10 V

1.01 V/div to 10 V/div ±100 V

50Ω coupling

SCALE range Offset range

1 mV/div to 50 mV/div ±0.5 V

50.5 mV/div to 99.5 mV/div ±0.25 V

100 mV/div to 500 mV/div ±5 V

505 mV/div to 1 V/div ±2.5 V

Offset accuracy SCALE range Offset range

1 mV/div to 9.95 mV/div ±((0.2%×| net offset |) +
1.5 mV + (0.1 div×
V/div setting))

10 mV/div to 99.5 mV/div ±((0.35%×| net offset |) +
1.5 mV + (0.1 div×
V/div setting))

100 mV/div to 1 V/div ±((0.35%×| net offset |) +
15 mV + (0.1 div× V/div
setting))

1.01 V/div to 10 V/div ±((0.25%×| net offset |) +
150 mV) + (0.1 div×
V/div setting))

At temperatures above
40 °C:
±((0.75%× | Net Offset |)
+ 150 mV + (0.1 div×
V/div setting))

where, net offset = offset -- ( position× volts/division)
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Table A- 2: Channel input and vertical specifications (Cont.)

Characteristic Description

DC gain accuracy, Sample or
Average acquisition mode

±1.5% + 1.0%× |net offset /offset range|

2 mV/div -- 3.98 mV/div: ±3% + 1.0%× |net offset /offset
range|

Refer to Offset Range specifications

DC voltage measurement accuracy Measurement type DC accuracy (in volts)

Sample acquisition mode,
typical

Absolute measurement of
any waveform point, and
High, Low, Max, and Min
measurements

±[1.5% + 1.0%× |net
offset /offset range|×
|reading -- net offset| +
offset accuracy + 0.13 div
× V/div setting + 0.6 mV]

2 mV/div -- 3.98 mV/div:
±[1.5% + 3.0%× |net
offset /offset range|×
|reading -- net offset| +
offset accuracy + 0.13 div
×V/div setting + 0.6 mV]

Delta voltage measurement
between any two points
acquired under the same
setup and ambient condi-
tions, and all other auto-
matic measurements

±[1.5% + 1.0%× |net
offset /offset range|×
|reading -- net offset| + 0.26
div× V/div setting +
1.2 mV]

2 mV/div -- 3.98 mV/div:
±[1.5% + 3.0%× |net
offset /offset range|×
|reading -- net offset| + 0.26
div×V/div setting
+ 1.2 mV]

where, net offset = offset -- (position× volts/division)
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Table A- 2: Channel input and vertical specifications (Cont.)

Characteristic Description

Average acquisition mode
(≥16 averages)

Absolute measurement of
any waveform point, and
High, Low, Max, and Min
measurements

±[1.5% + 1.0%× |net
offset /offset range|]×
|reading -- net offset |
+ 0.06 div× V/div + offset
accuracy]

2 mV/div -- 3.98 mV/div:
±[1.5% + 3.0%× |net
offset /offset range|]×
|reading -- net offset + offset
accuracy + 0.06 div×
V/div]

Delta voltage measurement
between any two points
acquired under the same
setup and ambient condi-
tions, and all other auto-
matic measurements

±[1.5% + 1.0%× |net
offset /offset range|×
|reading -- net offset| +
0.1 div× V/div setting +
0.3 mV]

2 mV/div -- 3.98 mV/div:
±[1.5% + 3.0%× |net
offset /offset range|×
|reading -- net offset|
+ 0.1 div× V/div
+ 0.3 mV]

where, net offset = offset -- (position× volts/division)

Nonlinearity, typical < 1 LSB differential, < 1 LSB integral, independently
based

Effective bits, typical Sine wave input at the indicated frequency and peak to
peak amplitude, at 50 mV/division and 25 °C

Signal and input conditions Effective bits

1 MHz, 9.2 div, 5 GS/s
sample rate, Sample ac-
quisition mode

6.6 bits

1 MHz, 9.2 div, 10 MS/s
sample rate, HiRes acquisi-
tion mode

9.0 bits

1 GHz, 6.5 div, 5 GS/s
sample rate, Sample ac-
quisition mode

4.7 bits
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Table A- 3: Horizontal and acquisition system specifications

Characteristic Description

Acquisition modes Sample, Peak detect, Hi Res, Average, and Envelope

Acquisition rate Up to 100,000 waveforms per second in Fast Acquisition
mode

Up to 130 waveforms per second with Fast Acquisition off

Minimum record length 500 points

Maximum record length Depends on the number of active channels and the
amount of memory installed

Standard 100,000 points (3 or 4 channels)
200,000 points (2 channels)
400,000 points (1 channel)

Option 1M installed 500,000 points (3 or 4 channels)
1,000,000 points (2 channels)
2,000,000 points (1 channel)

Option 2M installed 2,000,000 points (3 or 4 channels)
4,000,000 points (2 channels)
8,000,000 points (1 channel)

Real-time sample rate range Number of channels ac-
quired

Sample rate range

1 1.25 S/s to 5 GS/s

2 1.25 S/s to 2.5 GS/s

3 or 4 1.25 S/s to 1.25 GS/s

Equivalent-time sample rate or
interpolated waveform rate range

2.5 GS/s to 250 GS/s

Equivalent-time acquisition can be enabled or disabled.
When disabled, waveforms are interpolated at the fastest
time base settings.

Seconds/division range 200 ps/div to 40 s/div

Maximum FastFrame update rate,
nominal

225,000 frames per second

Horizontal delay range 16 ns to 250 s

Long term sample rate and delay
time accuracy

±15 ppm over any ≥ 1 ms interval

RMS aperture uncertainty, typical ≤ [3 ps + (0.1 ppm× record duration)]
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Table A- 3: Horizontal and acquisition system specifications (Cont.)

Characteristic Description

Delta time measurement accuracy For a single channel, with signal amplitude > 5 div,
reference level set at 50%, interpolation set to sin(x)/x,
volts/division set to ≥ 5 mV/div, with (displayed
risetime)/(sample interval) ratio between 1.4 and 4, where
sample interval = 1/(real-time sample rate)

Conditions Accuracy

Single shot signal, Sample
or Hi Res acquisition mode,
Full bandwidth

± (15 ppm× | reading | +
0.3 sample intervals)

Average acquisition mode,
≥100 averages, Full band-
width

± (15 ppm× | reading | +
20 ps)

Table A- 4: Trigger specifications

Characteristic Description

Auxiliary input resistance, typical ≥ 1.5 kΩ

Maximum auxiliary input voltage ±20 V (DC or peak AC)

Edge Trigger Sensitivity Trigger Source Sensitivity

Any channel, DC coupled 0.35 div from DC to
50 MHz, increasing to 1 div
at 1 GHz

Auxiliary input 400 mV from DC to
50 MHz, increasing to
750 mV at 100 MHz

Edge trigger sensitivity, typical All sources, for vertical scale settings ≥10 mV/div and
≤1 V/div

Trigger coupling Sensitivity

NOISE REJ 3×the DC-coupled limits

AC Same as DC-coupled limits
for frequencies ≥60 Hz,
attenuates signals <60 Hz

HF REJ 1.5×the DC-coupled limits
from DC to 30 kHz, attenu-
ates signals >30 kHz

LF REJ 1.5×the DC-coupled limits
for frequencies ≥80 kHz,
attenuates signals <80 kHz
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Table A- 4: Trigger specifications (Cont.)

Characteristic Description

Advanced trigger sensitivity, typical For all trigger types except Edge, with vertical scale
settings ≥10 mV/div and ≤1 V/div

1.0 div, from DC to 500 MHz

Event count sensitivity, typical For sequential trigger delayed by events, with vertical
scale settings ≥10 mV/div and ≤1 V/div

1.0 div, from DC to 500 MHz

Trigger level or threshold range Trigger Source Sensitivity

Any channel ±10 divisions from center of
screen

Auxiliary input ±8 V

Line fixed at zero volts

Trigger level or threshold accuracy,
typical

Edge trigger, DC coupling, for signals having rise and fall
times ≤20 ns

Trigger Source Accuracy

Any channel ± [(2%×| setting -- net
offset | ) + (0.3 div× volts/
div setting) + offset accura-
cy]

Auxiliary Not calibrated or specified

where, net offset = offset -- (position× volts/division)

Set level to 50% function Operates with signals ≥30 Hz

Trigger position error, typical Edge trigger, DC coupling, for signals having a slew rate
at the trigger point of ≥ 0.5 div/ns

Acquisition mode Error

Sample, Average ± (1 displayed point + 1ns)

Envelope ± (2 displayed points + 1ns)

Trigger jitter, typical σ = 8 ps RMS

B Event (Delayed) trigger Trigger After Time Trigger on nth Event

Range Delay time = 16 ns to
250 s

Event count = 1 to 107

Minimum time between arm
(A Event) and trigger
(B Event), typical

2 ns from the end of the
time period to the B trigger
event

2 ns between the A trigger
event and the first B trigger
event

Minimum pulse width,
typical

— B event width ≥1 ns

Maximum frequency, typical — B event frequency
≤500 MHz
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Table A- 4: Trigger specifications (Cont.)

Characteristic Description

Advanced trigger timing For vertical scale settings ≥10 mV/div and ≤1 V/div

Minimum recognizable
event width or time

Minimum re-arm time to
recognize next event

Glitch type Minimum glitch width = 1 ns 2 ns + 5% of glitch width
setting

Runt or Window type Minimum runt width =
2 ns

2 ns

Runt or Window type (time
qualified)

Minimum runt width =
2 ns

8.5 ns + 5% of runt width
setting

Runt or Window type (logic
qualified)

Minimum runt width =
2 ns

8.5 ns + 5% of runt width
setting

Width type Minimum difference be-
tween upper and lower
limits = 1 ns

2 ns + 5% of upper limit
setting

Timeout type Minimum timeout time =
1 ns

2 ns + 5% of timeout set-
ting

Transition type Minimum transition time =
600 ps

8.5 ns + 5% of transition
time setting

Pattern type, typical Minimum time the pattern is
true = 1 ns

1 ns

State type, typical Minimum true time before
clock edge = 1 ns

Minimum true time after
clock edge = 1 ns

1 ns

Setup/Hold type, typical Minimum clock pulse width
from active edge to inactive
edge

Minimum clock pulse width
from inactive edge to active
edge

3 ns + hold time setting 2 ns

Setup and Hold parameters Limits

Setup time (time from data
transition to clock edge)

--100 ns minimum
+100 ns maximum

Hold time (time from clock
edge to data transition)

--1 ns minimum
+102 ns maximum

Setup time + Hold time
(algebraic sum of the two
settings)

+2 ns minimum
+202 ns maximum
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Table A- 4: Trigger specifications (Cont.)

Characteristic Description

Advanced trigger timer ranges Limits

Glitch type 1 ns to 1 s

Runt or Window type, wider
than

1 ns to 1 s

Runt or Window type, time
qualified

1 ns to 1 s

Width type 1 ns to 1 s

Timeout type 1 ns to 1 s

Transition type 1 ns to 1 s

Pattern type 1 ns to 1 s

Setup/Hold type Setup and Hold timers Limits

Setup time (time from data
transition to clock edge)

--100 ns to +100 ns

Hold time (time from clock
edge to data transition)

--1 ns to +100 ns

Setup time + Hold time
(algebraic sum of the two
settings)

+2 ns to +200 ns

Advanced trigger timer accuracy For Glitch, Timeout, or Width types

Time range Accuracy

1 ns to 500 ns ±(20% of setting + 0.5 ns)

520 ns to 1 s ±(0.01% of setting +
100 ns)

Trigger holdoff range 1.5 µs to 12 s,
minimum resolution is 8 µs for settings ≤1.2 ms

Table A- 5: Display specifications

Characteristic Description

Display type 211.2 mm (8.3 in) width× 158.4 mm (6.2 in) height,
264 mm (10.4 in) diagonal, liquid crystal active-matrix
color display

Display resolution 640 horizontal× 480 vertical pixels

Pixel pitch 0.33 mm horizontal, 0.33 mm vertical

Contrast ratio, typical 150:1

Response time, typical 50 ms, black to white
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Table A- 5: Display specifications (Cont.)

Characteristic Description

Display refresh rate 59.94 frames per second

Displayed intensity levels Supports Windows SVGA high-color mode (16- or 24-bit)

Table A- 6: Input/output port specifications

Characteristic Description

Probe Compensator Output Front-panel terminals

Output voltage Frequency

1.0 V (from base to top) ±
1.0% into a ≥ 10 kΩ load

1 kHz ± 5%

Analog Signal Output amplitude Rear-panel BNC connector, provides a buffered version of
the signal that is attached to the channel 3 input

20 mV/div ± 20% into a 1 MΩ load
10 mV/div ± 20% into a 50Ω load

Analog Signal Output bandwidth,
typical

100 MHz into a 50Ω load

Auxiliary Output levels Rear-panel BNC connector, provides a TTL-compatible,
negative-polarity pulse for each A or B trigger (selectable)

Vout high Vout low (true)

≥2.5 V into open circuit,
≥1.0 V into 50Ω load

≤0.7 V with ≤4 ma sink,
≤0.25 V into 50Ω load

Auxiliary Output pulse width, typical Pulse width varies, 1 �s minimum

External Reference Input Rear-panel BNC connector

9.8 MHz to 10.2 MHz

200 mV p-p to 7 V p-p

>1.5kΩ in series with ~10 nf DC blocking capacitor
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Table A- 6: Input/output port specifications (Cont.)

Characteristic Description

Side-panel I/O ports Ports located on the rear panel

Parallel port (IEEE 1284) DB-25 connector, supports the following modes:
-standard (output only)
bidirectional (PS-2 compatible)
bidirectional enhanced parallel port (IEEE 1284
standard, mode 1 or mode 2, v 1.7)
-bidirectional high-speed extended capabilities

Audio ports Miniature phone jacks for stereo microphone input and
stereo line output

USB ports (4) Allows connection or disconnection of USB keyboard,
mouse and/or other devices while scope power is on

Keyboard port PS-2 compatible, instrument power must be off to make
connection

Mouse port PS-2 compatible, instrument power must be off to make
connection

LAN port RJ-45 connector, supports 10 base-T and 100 base-T

Serial port DB-9 COM1 port, uses NS16C550-compatible UARTS,
transfer speeds up to 115.2 kb/s

SVGA video port Upper video port, DB-15 female connector, connect a
second monitor to use dual-monitor display mode,
supports Basic requirements of PC99 specifications

GPIB port IEEE 488.2 standard interface

Scope VGA video port Lower video port, DB-15 female connector, 31.6 kHz
sync, EIA RS-343A compliant, connect to show the
instrument display, including live waveforms, on an
external monitor

Table A- 7: Data storage specifications

Characteristic Description

CD-ROM Side-panel CD-RW drive

Floppy disk Front-panel 3.5 in floppy disk drive, 1.44 MB capacity

Hard disk Internal hard disk drive, ≥ 20 GB capacity
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Table A- 8: Power source specifications

Characteristic Description

Source voltage and frequency 100 to 240 V ±10%, 47 Hz to 63 Hz

Power consumption ≤220 W

Overvoltage Category Overvoltage Category II (as defined in IEC61010-1/A2)

Table A- 9: Mechanical specifications

Characteristic Description

Weight

Benchtop configuration 22 lbs (10 kg) instrument only
55 lbs (25 kg) when packaged for domestic shipment

Rackmount kit 4 lbs (1.8 kg) rackmount conversion kit
11 lbs (5 kg) kit packaged for domestic shipment

Dimensions

Benchtop configuration 11.2 in (284.5 mm) height,
12.8 in (325.1 mm) with feet extended
17.6 in (447 mm) width
11.35 in (288.3 mm) depth

Rackmount configuration
(Option 1R)

10.5 in (267 mm) height
19 in (483 mm) width
11.35 in (288.3 mm) depth

Cooling Fan-forced air circulation with no air filter.

Required clearances Top 0 in (0 mm)

Bottom 0.25 in (6.5 mm) minimum
or 0 in (0 mm) when stand-
ing on the extended feet

Left side 3 in (76 mm)

Right side 0 in
5 in (126 mm) required to
access CD-ROM

Front 0 in (0 mm)

Rear 0 in (0 mm)

Construction material Chassis parts are constructed of aluminum alloy, front
panel is constructed of plastic laminate, circuit boards are
constructed of glass laminate, outer shell is molded and
textured from a polycarbonate/ABS blend
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Table A- 10: Environmental specifications

Characteristic Description

Temperature

Operating +5 °C to +45 °C

Nonoperating --20 °C to +60 °C

Humidity

Operating 20% to 80% relative humidity with a maximum wet bulb
temperature of +29 °C at or below +45 °C, noncondens-
ing

Upper limit derated to 30% relative humidity at +45 °C

Nonoperating With no diskette in floppy disk drive

5% to 90% relative humidity with a maximum wet bulb
temperature of +29 °C at or below +60 °C, noncondens-
ing

Upper limit derated to 20% relative humidity at +60 °C

Altitude

Operating 10,000 ft (3,048 m)

Nonoperating 40,000 ft (12,190 m)

Random vibration

Operating 0.22 gRMS from 5 Hz to 500 Hz, 10 minutes on each axis

Nonoperating 2.28 gRMS from 5 Hz to 500 Hz, 10 minutes on each axis

Shock, nonoperating 30 g (11 ms half-sine wave or less)
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Table A- 11: Certifications and compliances

Category Standards or description

EC Declaration of Conformity --
EMC

Meets intent of Directive 89/336/EEC for Electromagnetic Compatibility. Compliance was
demonstrated to the following specifications as listed in the Official Journal of the European Union:EMC

EN 61326 Emissions1, 3 Class A Radiated and Conducted Emissions

EN 61326 Immunity 1, 2, 4

IEC 61000-4-2 Electrostatic Discharge Immunity
±4 kV contact discharge, ±8 kV air discharge,
performance criterion C

IEC 61000-4-3 RF field immunity
3 V/m, 80 MHz to 1 GHz,
80% amplitude modulated with a 1 kHz sinewave
performance criterion A

IEC 61000-4-4 Electrical Fast Transient/Burst Immunity
1 kV on AC mains, 500 V on !/O cables, performance criterion C

IEC 61000-4-5 AC Surge Immunity
500 V differential mode, 1 kV common mode,
performance criterion B

IEC 61000-4-6 RF Conducted Immunity
3 V, 150 kHz to 80 MHz, amplitude modulated with a
1 kHz sinewave, performance criterion A

IEC 61000-4-11 AC Mains Voltage Dips and Interruption Immunity
100% reduction for one cycle, performance criterion B

EN 61000-3-2 Power Harmonic Current Emissions

1 If interconnect cables are used, they must be low-EMI shielded cables such as the following
Tektronix part numbers or their equivalents: 012-0991-01, 012-0991-02 or 012-0991-03 GPIB
Cable; 012-1213-00 (or CA part number 0294-9) RS-232 Cable; 012-1214-00 Centronics
Cable; or LCOM part number CTL3VGAMM-5 VGA Cable.

2 The performance criteria for when the instrument is subjected to the conditions described
above are defined as follows:
A — ≤0.2 division waveform displacement or ≤0.4 division increase in peak-to-peak noise
B — temporary, self-recoverable degradation or loss of performance is allowed, but no change
of actual operating state or loss of stored data is allowed
C — temporary loss of function is allowed provided that the function is self recoverable or can
be restored by the operation of the controls

3 Radiated emissions may exceed the levels specified in EN 61326 when this instrument is
connected to a test object.

4 USB mouse and keyboard only, performance criterion C. Normal USB keyboard or mouse
operation can be restored by unplugging and reconnecting the USB connector to the
instrument. If the USB mouse, front-panel controls, or touch screen do not respond, press the
On/Standby switch for five seconds to cycle power.

FCC Radiated and conducted emissions do not exceed the levels specified in FCC47 CFR, Part 15,
Subpart B, for Class A equipment.
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Table A- 11: Certifications and compliances (cont.)

Category Standards or description

EC Declaration of Conformity --
Low Voltage

Compliance was demonstrated to the following specification as listed in the Official Journal of the
European Union:

Low Voltage Directive 73/23/EEC, amended by 93/68/EEC

EN 61010-1/A2:1995 Safety requirements for electrical equipment for measurement
control and laboratory use.

U.S. Nationally Recognized
Testing Laboratory Listing

UL3111-1, First Edition Standard for electrical measuring and test equipment.

Canadian Certification CAN/CSA C22.2, Safety requirements for electrical equipment for measurement,
No. 1010.1-92 control, and laboratory use.

Additional Compliance IEC61010-1/A2 Safety requirements for electrical equipment for measurement,
control, and laboratory use.

Installation (Overvoltage)
Category

Terminals on this product may have different installation (overvoltage) category designations. The
installation categories are:

CAT III Distribution-level mains (usually permanently connected). Equipment at this level is
typically in a fixed industrial location.

CAT II Local-level mains (wall sockets). Equipment at this level includes appliances, portable
tools, and similar products. Equipment is usually cord-connected.

CAT I Secondary (signal level) or battery operated circuits of electronic equipment.

Pollution Degree A measure of the contaminates that could occur in the environment around and within a product.
Typically the internal environment inside a product is considered to be the same as the external.
Products should be used only in the environment for which they are rated.

Pollution Degree 2 Normally only dry, nonconductive pollution occurs. Occasionally a
temporary conductivity that is caused by condensation must be
expected. This location is a typical office/home environment.
Temporary condensation occurs only when the product is out of
service.

Safety Certification Compliance

Equipment Type Test and measuring

Safety Class Class 1 (as defined in IEC 61010-1/A2) -- grounded product

Pollution Degree Pollution Degree 2 (as defined in IEC 61010-1/A2). Note: Rated for indoor use only.
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Appendix B: Performance Verification

This Performance Verification checks that the VM5000HD meets its video
measurement specifications (Table A--1 in Appendix A, Specifications).

Prerequisites

� The test signal generator and VM5000HD instrument require a minimum
20 minute warm-up time before doing any performance verification tests.

� Perform the VM5000HD instrument internal system diagnostics in the
Utilities menu. The instrument must pass the diagnostics before you can
verify performance.

� Perform the VM5000HD instrument Signal Path Calibration (SPC)
procedure. The instrument must pass the SPC before you can verify
performance.

Required Equipment

Table B- 1: Required test equipment

Item number and
description Minimum requirements Example Purpose

HD CAV Television Test
Signal generator
(one required)

Tektronix TG700 with AWVG7
module

All tests

Digital Multimeter
(one required)

5-1/2 digits, better than 0.1% DC
accuracy 0--1 V

Fluke 8842A or
Fluke model 45

AWVG7 signal output test

75Ω BNC Cable
(four required)

42 inches (106.68 cm) long Tektronix part number
012-0074-00

All tests

75Ω precision BNC
terminations
(four required)

0.025% Accuracy Tektronix part number
011-0102-03

All tests

Connector, Dual-Banana
(one required)

Female BNC-to-dual banana Tektronix part number
103-0090-00

AWVG7 signal output test

Connector, BNC ‘T’
(four required)

Male BNC-to-dual female BNC Tektronix part number
103-0030-00

All tests

Coupler, Dual-Input
BNC ‘T’ cable assembly (one
required)

Female BNC-to-dual male BNC Tektronix part number
067-0525-02

Channel delay match test
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VM5000HD Tests

This procedure determines the test signal generator output signal amplitude. You
will need this value for calculating measurements. This procedure assumes you
are using a Tektronix TG700 test signal generator with an AWVG7 module. If
you are using a different test signal source, modify the steps according to your
particular setup.

Equipment
required

HD CAV Television Test Signal generator (Tektronix TG700 with
AWVG7 module)

Digital multimeter

75Ω BNC Cable (1)

75Ω precision BNC terminations (1)

Connector, Dual-Banana (1)

Connector, BNC ‘T’ (1)

Prerequisites The test signal generator and multimeter must warm up for at least 20
minutes prior to doing this test.

NOTE. Make sure that the AWVG7 generator module and the multimeter have

had a warm up period of at least 20 minutes.

1. Connect the digital multimeter to the test signal source. Refer to Figure B--1
while doing the following steps:

a. Connect one end of a 75 Ω BNC cable to the upper CH 1 connector on
the AWVG7 generator module.

b. Connect the other cable end to the digital multimeter with a BNC ‘T’
connector, 75 Ω precision termination, and BNC female-to-dual banana
adapter.

Determine the AWVG7
Signal Output Amplitude
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TG700 with
AWVG7 module

CH3 CH2 CH1

DMM

BNC “T”
connector

75Ω Termination

BNC to Dual banana

Figure B- 1: Signal output amplitude test hookup

2. On the TG700, press theMODULE, FORMAT, and FRONT PANEL

ENABLE buttons simultaneously, and then release theMODULE and
FORMAT buttons. Continue to hold the FRONT PANEL ENABLE button
to display Factory Startup Mode.

3. Enable the DAC Gain (GBR) : 0 mV calibration signal as follows:

a. Press theMODULE button to display the AWVG7 main menu.

b. Press the up or down arrow button to select CALIBRATION.

c. Press the left or right arrow button to select DAC Gain (GBR).

d. Press the ENTER button.

e. Press the left or right arrow button to select 0 mV.

f. Press the ENTER button.

4. Enter the digital multimeter reading in Table B--2, row DC0, column CH1.

5. Move the BNC cable from the upper CH 1 connector to the upper CH 2
connector on the AWVG7 generator module.

6. Enter the digital multimeter reading in Table B--2, row DC0, column CH 2.

7. Move the BNC cable from the upper CH 2 connector to the upper CH 3
connector on the AWVG7 generator module.

8. Enter the digital multimeter reading in Table B--2, row DC0, column CH 3.

9. On the TG700, press the left or right arrow button to select 700.397 mV.
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10. Press the ENTER button.

11. Enter the digital multimeter reading in Table B--2, row DC700, column
CH 3.

12. Move the BNC cable from the upper CH 3 connector to the upper CH 2
connector on the AWVG7 generator module.

13. Enter the digital multimeter reading in Table B--2, row DC700, column
CH 2.

14. Move the BNC cable from the upper CH 2 connector to the upper CH 1
connector on the AWVG7 generator module.

15. Enter the digital multimeter reading in Table B--2, row DC700, column
CH 1.

16. Subtract the DC0 values from the DC700 values, for each of the three
channels in Table B--2. The resulting three numbers are the Blanking-to-
White levels for each channel.

Table B- 2: Measured blanking to white levels

CH 1 CH 2 CH 3

DC700 (measured)

DC0 (measured)

Blanking-to-white level
(DC700 minus DC0)
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This test verifies the measurement amplitude accuracy of the three video input
channels (CH 1, CH 2, CH 3) and digitizers. This checks the accuracy specifica-
tion for the Color Bars measurement, Multiburst Flag amplitude, and Sync
Amplitude. The accuracy specification for all three is ±2mV ±1.5% of reading.

Equipment
required

HD CAV Television Test Signal generator (Tektronix TG700 with
AWVG7 module)

75Ω BNC cables (4)

75Ω precision BNC terminations (4)

Connector, BNC ‘T’ (4)

Prerequisites The test signal generator must warm up for at least 20 minutes prior to
doing this test. You must have completed the procedure Determine the
AWVG7 Signal Outlet Amplitude on page B--2.

1. Connect the instrument to the test signal source. Refer to Figure B--2 while
doing the following steps:

a. Connect a 75 Ω BNC cables to each of the upper CH1, CH2, and CH3
AWVG7 outputs.

b. Connect the other end of each cable to a BNC ‘T’ connector and a
precision 75 Ω termination.

c. Connect the BNC ‘T’ connector to the VM5000HD, so that the cable
from the AWVG7 CH1 output goes to the VM5000HD CH1 input.

d. Connect the CH2 cable to the VM5000HD CH2 input and the CH3 cable
to the VM5000HD CH3 input.

Check Absolute
Amplitude Measurement

Accuracy
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CH4CH3CH2CH1

TG700 with
AWVG7 module

CH3 CH2 CH1

VM5000HD

BNC “T” connector

75Ω Termination

Figure B- 2: Amplitude accuracy test hookup

e. Connect a fourth 75 Ω BNC cable to the lower AWVG7 CH1 output.

f. Connect the other end of this cable to a BNC ‘T’ connector and a 75 Ω

termination.

g. Connect the BNC ‘T’ connector to the VM5000HD CH4 input.

2. On the TG700, press theMODULE, FORMAT, and FRONT PANEL

ENABLE buttons simultaneously to return the generator to normal operating
mode.

3. After it is finished loading, press MODULE repeatedly to display AWVG7.

4. Press FORMAT repeatedly to display 1080 59i GBR.

5. Press ENTER.

NOTE. Press and hold the FRONT PANEL ENABLE button to unlock the front

panel.

6. Press COLOR BAR repeatedly to display 100% Color Bars.

7. Start the VM5000HD application (File > Applications > VM5000HD).

8. Select File > Recall Default.

9. Select Configuration > Format, and select RGB Color Space.

10. Select Configuration > Operation, and select Channel 4 as the trigger.
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11. Select the VM5000HD Run button. The color bar measurement results table
should appear with continuously updated measurements.

12. In the Color bar measurements view, change the Averages setting to 64.

13. Record the VM5000HD measurement value for the white bar measurement,
for each of the three channels, in row 4 of Table B--3.

Table B- 3: White bar measurement

CH 1 (Y/G) CH 2 (B/Pb) CH 3 (R/Pr)

AWVG7 Blanking-to-White level
(DC700--DC0) (from Table B--2)

Lower white limit value (equation 1)

Upper white limit value (equation 2)

White measurement

Equation 1: Lower White limit value = (DC700--DC0) X (0.985) -- 2 mV

Equation 2: Upper White limit value = (DC700--DC0) X (1.015) + 2 mV

14. Calculate the instrument white bar measurement as follows:

a. Copy the AWVG7 Blanking-to-White level values (from Table B--2, row
3) for each channel in row 1 of Table B--3.

b. For each channel, calculate the Lower VM5000HD white limit, using
equation 1, and enter the values in row 2, Table B--3.

c. For each channel, calculate the Upper VM5000HD white limit, using
equation 2, and enter the values in row 3, Table B--3.

15. Check that the VM5000HD white measurement (row 4) falls between the
Lower (Line 2) and Upper (Line 3) limit values, for all three channels.

Table B--4 is an example of typical measurements and the calculation results.
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Table B- 4: Example white bar measurement values

CH 1 (Y/G) CH 2 (B/Pb) CH 3 (R/Pr)

AWVG7 Blanking-to-White level
(DC700--DC0) (from Table B--2)

700.05 mV 700.00 mV 701.04 mV

Lower white limit value (equation 1) 687.55 mV 687.50 mV 688.52 mV

Upper white limit value (equation 2) 712.55 mV 712.50 mV 713.56 mV

White measurement 696.55 mV 700.25 mV 695.01 mV

Equation 1: Lower White limit value = (DC700--DC0) X (0.985) -- 2 mV

Equation 2: Upper White limit value = (DC700--DC0) X (1.015) + 2 mV

The calculated VM5000HD white measurements in row 4 are between the
LOWER and UPPER limit values (rows 2 and 3), so the measurements are
within specification for all channels.



Appendix B: Performance Verification

VM5000HD Automatic Video Measurement Set User Manual B- 9

This test verifies the frequency response accuracy of the three VM5000HD video
input channels (CH 1, CH 2, CH 3) and digitizers. This directly checks the
Multiburst measurement accuracy, and indirectly the Noise measurement up
through 30 MHz. The Multiburst accuracy specification is ±0.5dB up through
10MHz, and ±0.75dB from 10 to 30 MHz.

Equipment
required

HD CAV Television Test Signal generator (Tektronix TG700 with
AWVG7 module)

75Ω BNC cables (4)

75Ω precision BNC terminations (4)

Connector, BNC ‘T’ (4)

Prerequisites The test signal generator must warm up for at least 20 minutes prior to
doing this test.

NOTE. The AWVG7 must meets its frequency response specification of

±1%(0.09dB) to 20 MHz, ±2%(0.17dB) to 28 MHz, and ±3%(0.26dB) to

30 MHz. If you are uncertain about the test signal generator calibration status,

perform the AWVG7 frequency response performance verification described in

the AWVG7 Service Manual.

1. Connect the instrument to the test signal source. Refer to Figure B--3 while
doing the following steps:

a. Connect 75 Ω BNC cables to the upper CH1, CH2, and CH3 AWVG7
outputs.

b. Connect the other end of each cable to a BNC T connector and a 75 Ω

termination.

c. Connect the BNC T connector to the VM5000HD, so that the cable from
the AWVG7 CH1 output goes to the VM5000HD CH1 input.

d. Connect the CH2 cable to the VM5000HD CH2 input and the CH3 cable
to the VM5000HD CH3 input.

e. Connect a fourth 75 Ω BNC cable to the lower AWVG7 CH1 output.

f. Connect the other end of this cable to a BNC T connector and a 75 Ω

termination.

g. Connect the BNC T connector to the VM5000HD CH4 input.

Check Frequency
Response Measurement

Accuracy
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CH4CH3CH2CH1

TG700 with
AWVG7 module

CH3 CH2 CH1

VM5000HD

BNC “T” connector

75Ω Termination

Figure B- 3: Frequency accuracy test hookup

2. On the TG700, press Module repeatedly to display AWVG7.

3. Press FORMAT repeatedly to display 1080 59i GBR.

4. Press ENTER.

5. Press Multiburst repeatedly to display Multiburst 1--10 MHz.

NOTE. Press and hold the FRONT PANEL ENABLE button to unlock the front

panel.

6. Start the VM5000HD application (File > Applications > VM5000HD).

7. Select File > Recall Default.

8. Select Configuration > Format.

9. Select RGB Color Space.

10. Select Configuration > Measurements.

11. Select theMultiburst check box and deselect the Color Bars check box.

12. Select Configuration > Operation, and select Channel 4 as the trigger.

13. Select Results > Multiburst.

14. Select the VM5000HD Run button. The Multiburst measurement results
table should display with continuously updated measurements.
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15. Change the Averages setting to 64.

16. Check the following:

a. The six Multiburst packet Amp(dB) readings (1, 2, 4, 6, 8, and 10 MHz)
should be less than ±0.5 dB, for each of the three channels (G, B, R).

b. The flag amplitude for each channel should be 420.0 mV ±8.3 mV.

17. Select the VM5000HD Stop button to halt measurement.

18. Press the TG700 Multiburst button repeatedly to display Multi-

burst 10--20 MHz.

19. Select the VM5000HD Run button.

20. Check the following:

a. The six Multiburst packet Amp(dB) readings (10, 12, 14, 16, 18, and 20
MHz) should be less than ±0.75 dB, for each of the three channels
(G, B, R).

b. The flag amplitude for each channel should be 420.0 mV ±8.3 mV.

21. Select the VM5000HD Stop button to halt measurement.

22. Press the TG700 Multiburst button repeatedly to display Multiburst

20--30 MHz.

23. Select the VM5000HD Run button.

24. Check the following:

a. The six Multiburst (20, 22, 24, 26, 28, and 30 MHz) packet Amp(dB)
readings are less than ±0.75 dB, for each of the three channels (G, B, R).

b. The flag amplitude for each channel should be 420.0 mV ±8.3 mV.

This test verifies the noise floor of the three VM5000HD video input channels
(CH 1, CH 2, CH 3) and digitizers. Noise floor affects the linearity of the noise
measurement between --60 and --70 dB. The --76 dB Noise Floor specification
ensures a noise floor error contribution of less than 1 dB for a --70 dB noise
measurement. Together with the Amplitude Accuracy (Check A) and Frequency
Response (Check B) checks, this indirectly checks the Noise measurement
accuracy.

Check Noise Floor
Measurement Accuracy



Appendix B: Performance Verification

B- 12 VM5000HD Automatic Video Measurement Set User Manual

Equipment
required

HD CAV Television Test Signal generator (Tektronix TG700 with
AWVG7 module)

75Ω BNC cable (1)

75Ω precision BNC terminations (4)

Connector, BNC ‘T’ (1)

Prerequisites The test signal generator must warm up for at least 20 minutes prior to
doing this test.

1. Connect the instrument to the test signal source. Refer to Figure B--4 while
doing the following steps:

a. Connect a 75 Ω BNC cable to the CH1 AWVG7 outputs.

b. Connect the other end of the cable to the VM5000HD CH 4 input and a
75 Ω termination using a BNC ‘T’ connector.

c. Place 75 Ω terminations on the VM5000HD CH 1, CH 2, and CH 3
inputs.

CH4CH3CH2CH1

TG700 with
AWVG7 module

CH3 CH2 CH1

VM5000HD

BNC “T” connector

75Ω Termination

Figure B- 4: Noise floor accuracy test hookup

2. Start the VM5000HD application (File > Applications > VM5000HD).

3. Select File > Recall Default.

4. Select Configuration > Format and select RGB Color Space.

5. Select Configuration > Measurements.

6. Select the Noise check box and deselect the Color Bars check box.
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7. Select Configuration > Operation, and select Channel 4 as the trigger.

8. Select Results > Noise.

9. Select Unweighted BW in the Filter area.

10. Adjust the Bandwidth Hz setting to 30.0 MHz.

11. Change the Averages setting to 64.

12. Select the VM5000HD Run button. The Noise measurement results table
should appear with continuously updating measurements.

13. Check that the noise measurement dB values are greater than 76 dB for all
three channels.

For example, a 78 dB reading passes. A 74 dB reading fails.

This check verifies the delay match between the VM5000HD CH 1, CH 2, and
CH 3 measurement channels. Delay match error affects Channel Delay measure-
ment accuracy. The specification for delay match error between any two channels
is less than 1 ns.

Equipment
required

HD CAV Television Test Signal generator (Tektronix TG700 with
AWVG7 module)

75Ω BNC cables (2)

75Ω precision BNC terminations (2)

Connector, BNC ‘T’ (2)

Coupler, Dual-Input BNC ‘T’ cable assembly (1)

Prerequisites The test signal generator must warm up for at least 20 minutes prior to
doing this test.

1. Connect the instrument to the test signal source. Refer to Figure B--5 while
doing the following steps:

a. Connect a 75 Ω BNC cable to the upper CH1 AWVG7 output.

b. Connect the other end of the cable to a BNC ‘T’ connector, BNC ‘T’
Cable Assembly, and 75 Ω termination.

c. Connect the BNC ‘T’ Cable Assembly to the VM5000HD CH 1 and
CH 2 inputs.

d. Connect a second 75 Ω BNC cable to the lower CH1 AWVG7 output.

Check Channel Delay
Match
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e. Connect the other end of the cable to the VM5000HD CH 4 input and a
75 Ω termination using a BNC ‘T’ connector.

CH4CH3CH2CH1

TG700 with
AWVG7 module

CH3 CH2 CH1

VM5000HD

BNC “T” connector

75Ω Termination

BNC “T” connector

75Ω Termination

BNC “T” cable assembly

Figure B- 5: Channel delay match test hookup

2. On the TG700, press theModule button repeatedly to display AWVG7.

3. Press FORMAT repeatedly to display 1080 59i GBR.

4. Press ENTER.

5. Press Multiburst repeatedly to display Multiburst 10--20 MHz.

NOTE. Press and hold the FRONT PANEL ENABLE button to unlock the front

panel.

6. Start the VM5000HD application (File > Applications > VM5000HD).

7. Select File > Recall Default.

8. Select Configuration > Format and select RGB Color Space.

9. While still in Configuration > Measurements, select the Channel Delay
check box and deselect the Color Bars check box.

10. Select Configuration > Operation:
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a. Deselect all theWarning Reporting boxes.

b. Select Channel 4 as the trigger.

11. Select Results > Channel Delay.

12. Change the Averages setting to 64.

13. Select the VM5000HD Run button. The Channel Delay measurement results
table should appear with continuously updating measurements.

14. Note the G-B measurement results (including sign) in row 1 of Table B--5.

15. Reverse the BNC ‘T’ Cable connections on CH 1 and CH 2.

16. Note the G-B measurement results (including sign) in row 2 of Table B--5.

17. Subtract line 2 from line 1 in Table B--5. Divide this result by 2 and enter it
in row 3 of Table B--5.

Table B- 5: Delay error measurements

G-B (ns) G-R (ns) B-R (ns)

Connection 1

Connection 2

Net delay error (equation 3)

Equation 3: [(Connection 1) -- (Connection 2)] ÷ 2

18. Connect the BNC ‘T’ Cable to the VM5000HD CH 1 and CH 3 inputs.
Repeat the procedure in steps 14 through 17 for the G-R measurement.

19. Connect the BNC ‘T’ Cable to the VM5000HD CH 2 and CH 3 inputs.
Repeat the procedure in steps 14 through 17 for the B-R measurement.

20. Check that the net delay error (row 3) is less than ±1 ns for G-B, G-R,
and B-R.

This completes the VM5000HD performance verification.



Appendix B: Performance Verification

B- 16 VM5000HD Automatic Video Measurement Set User Manual



VM5000HD Automatic Video Measurement Set User Manual C- 1

Appendix C: Remote Commands

You can control the VM5000HD through the GPIB interface using commands
and queries. The remote commands have the same functionalities as the menus
and buttons in the user interface. You can see the effect of the commands on the
interface as they are received.

NOTE. All oscilloscope platform GPIB commands are supported on the

VM5000HD instrument. For documentation on these commands, please refer to

the TDS5000 GPIB Online Programmer Guide provided on the TDS5000

product software CD (063-3508-XX); see the installation instructions in the CD

booklet.

This section covers the following information:

� Syntax, page C--1

� Remote Startup and Exit of the Instrument, page C--3

� Command Groups, page C--4

� Commands, on page C--8

� Warning and Error Messages, on page C--70

Syntax

Commands consist of set commands and query commands (usually simply called
commands and queries). Commands modify the VM5000HD settings or tell the
instrument to perform a specific action. Queries cause the VM5000HD to return
data and information about its status.

Most commands have both a set and a query form, although some commands
only have a query form.

VM5000HD instrument commands have the structure:

:VARIable:VALue ”<Command>”, ”<Argument>”

� You can abbreviate VARIable:VALue to VARI:VAL if desired, and it is case
insensitive.

� There are no abbreviated versions of the ”<Command>”, ”<Argument>” part
of the VM5000HD commands; you must enter the full name of this part of a
command.

Command Structure
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� The <Command> field is case sensitive, and use of incorrect command case
spelling can result in unexpected results.

� All commands have a single <Argument>, which is case insensitive and
cannot be the empty string “”.

� Arguments are limited to a maximum of 60 characters. Arguments longer
than 60 characters can cause unexpected behavior of the instrument and may
require the application to be restarted, so this should be avoided.

� The comma character (,) and the double quote character (”) are special
characters and should not be used in the argument, otherwise unexpected
behavior can result. All other printable characters are permitted in the
argument.

� Commands that accept numeric arguments accept either integer or floating
point values, with or without an exponent. This is equivalent to GPIB
standard numeric formats <NR1>, <NR2>, and <NR3>.

� The VM5000HD instrument does not support using a semicolon (;) to
concatenate commands.

VM5000HD instrument queries have the structure:

:VARIable:VALue? ”<Command>”

� You can abbreviate VARIable:VALue? to VARI:VAL? if desired, and it is case
insensitive.

� There are no abbreviated versions of the ”<Command>” part of the
VM5000HD queries; you must enter the full name of a query.

� The <Command> field is case sensitive, and use of incorrect command case
spelling can result in unexpected results.

� The VM5000HD does not support using a semicolon (;) to concatenate
queries.

� Query responses are always in upper case.

� The units and precision of result queries are identical to those in the user
interface and those produced by generating a report.

Query Structure
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Remote Startup and Exit of the Instrument

To start the application using remote commands, use the following command:

application:activate “VM5000HD”

To exit the application using remote commands, use the following command:

VARIable:VALue “application”, “exit”

You can check whether or not the VM5000HD application is running using the
following query:

VARIable:VALue? ”application”

If the application is running, this query will return “VM5000HD”. However, if
the application is not currently running, it will return the empty string “”.
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Command Groups

Tables C--1 through C--7 list the commands organized by functional group.
(Refer to the Table of Contents for a list of all the commands in alphabetical
order.)

Table C- 1: Configuration commands

Header Description

:VARIable:VALue

AutoScale Set or query whether to use auto scale during measurement

ChannelDelaySet Set or query whether to measure channel delay upon Execute

ColorBarsSet Set or query whether to measure Color Bars upon Execute

ColorSpace Set or query the video color space to use for measurement

Format Set or query the video format to use for measurement

MultiBurstSet Set or query whether Multiburst is to be measured upon Execute

NoiseSet Set or query whether Noise is to be measured upon Execute

NonLinearitySet Set or query whether Non-Linearity is to be measured upon Execute

RunMode Set or query run mode to use for measurement

SetupAndOrRun Set or query setup mode to use for measurement

SyncSet Set or query whether Sync is to be measured upon Execute

Trigger Set or query the video trigger to use for measurement

WarningReportingMeasure Set or query whether measurement warnings create a warning message

WarningReportingResults Set or query whether results warnings are to create a warning message

WarningReportingSignal Set or query whether signal warnings create a warning message

Table C- 2: Miscellaneous commands

Header Description

:VARIable:VALue

Error Reset error to 0 or query error value.

ID? Query the ID/Version of the application

OPComplete Controls VM5000HD GPIB scripts by ensuring that the previous command is
ready before either querying its value or calling the next command.

Warning Reset warning to 0 or query warning value.
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Table C- 3: Reports commands

Header Description

:VARIable:VALue

ReportGenerate Generates a measurement report of the specified type (if a measure has been
run and results are available), and saves it in the specified file

ReportMeasurements Set or query the measurements to write to the report when ReportGenerate is
called

ReportString Set or query any additional information to write to the report when
ReportGenerate is called

Table C- 4: Results commands

Header Description

:VARIable:VALue:

ChannelDelayAll? Query all three delay measurements performed by Channel Delay

ChannelDelayCh1Ch2? Query the Ch1Ch2 delay measurement performed by Channel Delay

ChannelDelayCh1Ch3? Query the Ch1Ch3 delay measurement performed by Channel Delay

ChannelDelayCh2Ch3? Query the Ch2Ch3 delay measurement performed by Channel Delay

ColorBarsmVCh[1..3]? Query all eight level values resulting from Color Bars measurement for the
specified channel

ColorBarsmVCh[1..3]Val[1..8]? Query the value resulting from the specified Color Bars channel and value
measurement

MultiburstAmpdBCh[1..3]? Query all six amplitude values resulting from the specified Multiburst channel
measurement

MultiburstAmpdBCh[1..3]Val[1..6]? Query the amplitude value resulting from the specified Multiburst channel and
value measurement

MultiburstFlagmVCh[1..3]? Query the Flag value resulting from Multiburst measurement for the specified
channel

MultiburstFreqCh[1..3]? Query all six frequency values resulting from the specified Multiburst channel
measurement

MultiburstFreqCh[1..3]Val[1..6]? Query the frequency value resulting from the specified Multiburst channel and
value measurement

NoiseAmpdBCh[1..3]? Query amplitude value (in dB) resulting from Noise measurement for the
specified channel

NoiseAmpmVCh[1..3]? Query amplitude value (in mV) resulting from Noise measurement for the
specified channel

NonLinearityPctCh[1..3]? Query all six non-linearity values resulting from the Non-Linearity measurement
for the specified channel

NonLinearityPctCh[1..3]Max? Query the maximum non-linearity value for the specified channel

NonLinearityPctCh[1..3]Val[1..5]? Query the maximum non-linearity value for the specified channel and value
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Table C- 4: Results commands (Cont.)

Header Description

SyncLevelsmV? Query all synchronization levels resulting from the Sync measurement

SyncLevelsmVVal[1..3]? Query the specified synchronization level resulting from the Sync measurement

SyncTimes? Query all synchronization times resulting from the Sync measurement

SyncTimesVal[1..7]? Query the specified synchronization time resulting from the Sync measurement

Table C- 5: Run commands

Header Description

:VARIable:VALue

Execute Execute or stop the current set measurement(s), or query whether any
measurement is currently being executed

Table C- 6: Settings commands

Header Description

:VARIable:VALue

DefaultSettings Restore default (factory) settings

RecallSettings Recall settings stored in the specified path/filename

SaveSettings Save current settings in the specified path/filename

Table C- 7: Setup commands

Header Description

:VARIable:VALue

ChannelDelayAverage Set or query the number of samples over which to average the Channel Delay
measurement

ChannelDelayLine Set or query line number that is to be used for the Channel Delay measure-
ment

ColorBarsAverage Set or query the number of samples over which to average the Color Bars
measurement

ColorBarsLine Set or query line number that is to be used for the Color Bars measurement

MultiburstAverage Set or query the number of samples over which to average the Multiburst
measurement

MultiburstLine Set or query line number that is to be used for the Multiburst measurement
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Table C- 7: Setup commands (Cont.)

Header Description

NoiseAverage Set or query the number of samples over which to average the Noise
measurement

NoiseBW Set or query bandwidth of noise filter that is to be used for Noise measure-
ment, if the unweighted noise filter is selected

NoiseFilter Set or query type of noise filter that is to be used for Noise measurement

NoiseLine Set or query line number that is to be used for the Noise measurement

NonLinearityAverage Set or query the number of samples over which to average the Non-Linearity
measurement

NonLinearityLine Set or query line number that is to be used for the Non-Linearity measurement

SyncAverage Set or query the number of samples over which to average the Sync
measurement

SyncLine Set or query line number that is to be used for the Sync measurement
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Commands

The following remote commands are listed in alphabetical order.

AutoScale < setting >

Set or query whether auto scale is to be used during measurement.

VARIable:VALue “AutoScale”, “< setting >”
VARIable:VALue? “AutoScale”

Configuration

< setting > specifies auto scale setting that is to be used.
Valid settings are: OFF, ON, 0, 1.

Query returns the current specified setting.

VARIable:VALue “AutoScale”, “ON”
VARIable:VALue? “AutoScale”

Query may return: “AutoScale 0”

Syntax

Group

Arguments

Returns

Examples
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ChannelDelayAll?

Query all 3 delay measurements performed by Channel Delay.

VARIable:VALue? “ChannelDelayAll”

Results

None

ChannelDelayCh1Ch2
ChannelDelayCh1Ch3
ChannelDelayCh2Ch3

Returns all three delay measurements (in nanoseconds) performed by Channel
Delay, in this order: Ch1Ch2 Ch1Ch3 Ch2Ch3.

Returns “---” if no valid measurement currently available.

VARIable:VALue? “ChannelDelayAll”

Query may return: “ChannelDelayAll 1.84 0.04 –1.54”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ChannelDelayAverage < samples >

Set or query the number of samples over which to average the Channel Delay
measurement.

VARIable:VALue “ChannelDelayAverage”, “< samples >”
VARIable:VALue? “ChannelDelayAverage”

Setup

< samples > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current number of samples for Channel Delay measurement.

VARIable:VALue “ChannelDelayAverage”, “1”
VARIable:VALue? “ChannelDelayAverage”

Query may return: “ChannelDelayAverage 8”

Syntax

Group

Arguments

Returns

Examples



Appendix C: Remote Commands

VM5000HD Automatic Video Measurement Set User Manual C- 11

ChannelDelayCh1Ch2?

Query the Ch1Ch2 delay measurement performed by Channel Delay.

VARIable:VALue? “ChannelDelayCh1Ch2”

Results

None

ChannelDelayAll
ChannelDelayCh1Ch3
ChannelDelayCh2Ch3

Returns the Ch1Ch2 delay measurement (in nanoseconds) performed by Channel
Delay.

Returns “---” if no valid measurement is currently available.

VARIable:VALue? “ChannelDelayCh1Ch2

Query may return: “ChannelDelayCh1Ch2 1.84”

Syntax

Group

Arguments

Related Commands

Returns

Examples



Appendix C: Remote Commands

C- 12 VM5000HD Automatic Video Measurement Set User Manual

ChannelDelayCh1Ch3?

Query the Ch1Ch3 delay measurement performed by Channel Delay.

VARIable:VALue? “ChannelDelayCh1Ch3”

Results

None

ChannelDelayAll
ChannelDelayCh1Ch2
ChannelDelayCh2Ch3

Returns the Ch1Ch3 delay measurement (in nanoseconds) performed by Channel
Delay.

Returns “---” if no valid measurement currently available.

VARIable:VALue? “ChannelDelayCh1Ch3”

Query may return: “ChannelDelayCh1Ch3 0.04”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ChannelDelayCh2Ch3?

Query the Ch2Ch3 delay measurement performed by Channel Delay.

VARIable:VALue? “ChannelDelayCh2Ch3”

Results

None

ChannelDelayAll
ChannelDelayCh1Ch2
ChannelDelayCh1Ch3

Returns the Ch2Ch3 delay measurement (in nanoseconds) performed by Channel
Delay.

Returns “---” if no valid measurement is currently available.

VARIable:VALue? “ChannelDelayCh2Ch3”

Query may return: “ChannelDelayCh2Ch3 –1.54”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ChannelDelayLine < linenumber >

Set or query line number that is to be used for Channel Delay measurement.

VARIable:VALue “ChannelDelayLine”, “< linenumber >”
VARIable:VALue? “ChannelDelayLine”

Setup

< linenumber > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Channel Delay measurement.

VARIable:VALue “ChannelDelayLine”, “200”
VARIable:VALue? “ChannelDelayLine”

Query may return: “ChannelDelayLine 325”

Syntax

Group

Arguments

Returns

Examples
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ChannelDelaySet < setting >

Set or query whether Channel Delay is to be measured upon Execute.

VARIable:VALue “ChannelDelaySet”, “< setting >”
VARIable:VALue? “ChannelDelaySet”

Configuration

< setting > specifies whether to perform Channel Delay measurement upon
Execute.
Valid values are: OFF, ON, 0, 1.

Execute
ReportMeasurements

Query returns 0 or 1 depending on whether ChannelDelaySet measurement is
selected.

VARIable:VALue “ChannelDelaySet”, “ON”
VARIable:VALue? “ChannelDelaySet”
Query may return: “ChannelDelaySet 1”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ColorBarsAverage < samples >

Set or query the number of samples over which to average the Color Bars
measurement.

VARIable:VALue “ColorBarsAverage”, “< samples >”
VARIable:VALue? “ColorBarsAverage”

Setup

< samples > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current number of samples for Color Bars measurement.

VARIable:VALue “ColorBarsAverage”, “1”
VARIable:VALue? “ColorBarsAverage”

Query may return: “ColorBarsAverage 8”

Syntax

Group

Arguments

Returns

Examples



Appendix C: Remote Commands

VM5000HD Automatic Video Measurement Set User Manual C- 17

ColorBarsLine < linenumber >

Set or query line number that is to be used for Color Bars measurement.

VARIable:VALue “ColorBarsLine”, “< linenumber >”
VARIable:VALue? “ColorBarsLine”

Setup

< linenumber > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Color Bars measurement.

VARIable:VALue “ColorBarsLine”, “200”
VARIable:VALue? “ColorBarsLine”

Query may return: “ColorBarsLine 325”

Syntax

Group

Arguments

Returns

Examples
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ColorBarsmVCh[1..3]?

Query all eight level values (in mV) resulting from the Color Bars measurement
for the specified channel.

VARIable:VALue? “ColorBarsmVCh[1..3]”

Results

None

ColorBarsmVCh[1..3]Val[1..8]

Returns all eight delay measurements (in mV) performed by Color Bars, in this
order: White Yellow Cyan Green Magenta Red Blue Black.

Returns “---” if no valid measurement is currently available.

VARIable:VALue? “ColorBarsmVCh1”

Query may return:
“ColorBarsmVCh1 699.76 650.52 552.75 501.98 201.89 150.74 52.11
0.49”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ColorBarsmVCh[1..3]Val[1..8]?

Query the value (in mV) resulting from Color Bars measurement for the
specified channel and value.

VARIable:VALue? “ColorBarsmVCh[1..3]Val[1..8]”

Results

None

ColorBarsmVCh[1..3]

Returns the specified Color Bars value (in mV).

Values must be in the range: 1..8
Values must designate the following colors:
1--White 2--Yellow 3--Cyan 4--Green 5--Magenta 6--Red 7--Blue 8--Black.

Returns “---” if no valid measurement is currently available

VARIable:VALue? “ColorBarsmVCh2Val6”

Query may return: “ColorBarsmVCh2Val6 –78.89”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ColorBarsSet < setting >

Set or query whether Color Bars is to be measured upon Execute.

VARIable:VALue “ColorBarsSet”, “< setting >”
VARIable:VALue? “ColorBarsSet”

Configuration

< setting > specifies whether to perform Color Bars measurement upon
Execute. Valid values are: OFF, ON, 0, 1

Execute
ReportMeasurements

Query returns 0 or 1 depending on whether ColorBarsSet measurement is
selected.

VARIable:VALue “ColorBarsSet”, “ON”
VARIable:VALue? “ColorBarsSet”

Query may return: “ColorBarsSet 1”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ColorSpace < colorspace >

Set or query video color space to use for measurement.

VARIable:VALue “ColorSpace”, “< colorspace >”
VARIable:VALue? “ColorSpace”

Configuration

< colorspace > specifies color space that is to be set.
Valid color spaces are: YPbPr, RGB

Query returns the current specified color space

VARIable:VALue “ColorSpace”, “YPbPr”
VARIable:VALue? “ColorSpace”

Query may return: “ColorSpace YPbPr”

Syntax

Group

Arguments

Returns

Examples
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DefaultSettings

Command restores default (factory) settings.
Query returns “OK” unless the command is still being processed, in which case
it returns “1”.

Restores default (factory) settings.

VARIable:VALue “DefaultSettings”, “1”
VARIable:VALue? “DefaultSettings”

Settings

Valid value is 1.

Query returns “OK” unless the command is still being processed, in which case it
returns “1”.

VARIable:VALue “DefaultSettings”, “1”
VARIable:VALue? “DefaultSettings”

Query may return: “DefaultSettings OK”

Syntax

Group

Arguments

Returns

Examples
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Error < setting >

Command can be used to reset Error to “0”.
Query returns the most recent error reported by the application, or “0” if no
errors have occurred since Error was last reset.

Initialized to “0” on startup.

VARIable:VALue “Error” < setting >
VARIable:VALue? “Error”

Miscellaneous

< setting > resets Error to “0”.
Valid values are: OFF, 0.

Returns the most recent error reported by the application. Returns “0” if no error
has occurred since the Error command was last reset. For a listing of all possible
errors, refer to Table C--9 on page C--71.

VARIable:VALue “Error”, “OFF”
VARIable:VALue? “Error”

Query may return: “Error No Measurement Selected”

Syntax

Group

Arguments

Returns

Examples



Appendix C: Remote Commands

C- 24 VM5000HD Automatic Video Measurement Set User Manual

Execute < setting >

Execute/stop the current set measurement(s), or query whether any measurement
is currently being executed. If the measurement is already in the mode specified
by the setting, the command has no effect. For example, if a measurement is
already running and ‘‘VARIable:VALue “Execute”, “1” is received, the measure-
ment will continue to run.

VARIable:VALue “Execute”, “< setting >”
VARIable:VALue? “Execute”

Run

< setting > Valid settings are: OFF, 0, ON, 1.
OFF is the same as 0, and ON is the same as 1.

ChannelDelaySet
ColorBarSet
MultiburstSet
NoiseSet
NonLinearitySet
SyncSet

Query returns 1 if any measurement is currently being executed, otherwise it
returns 0.

VARIable:VALue “Execute”, “1”
VARIable:VALue? “Execute”

Query may return: “Execute 1”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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Format < format >

Set or query video format to use for measurement. No defaults.

If you get the error message, “Invalid Argument”, make sure that you specified a
valid format.

VARIable:VALue “Format”, “< format >”
VARIable:VALue? “Format”

Configuration

< format > specifies format that is to be set.
Valid formats are: HD480P60, HD576P50, HD720P60, HD1080I50,
HD1080I60, SXGAP60

Query returns the current specified format.

VARIable:VALue “Format”, “HD480P60”
VARIable:VALue? “Format”

Query may return: “Format HD1080I60”

Syntax

Group

Arguments

Returns

Examples
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ID?

Query the ID/Version of the application.

VARIable:VALue? “ID”

Miscellaneous

None

Returns the application’s ID

VARIable:VALue? “ID”

Query may return: “ID Tek/VM5000HD FV:1.0”

Syntax

Group

Arguments

Returns

Examples
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MultiburstAmpdBCh[1..3]?

Query all six amplitude values (in dB) resulting from Multiburst measurement
for the specified channel.

VARIable:VALue? “MultiburstAmpdBCh[1..3]”

Results

None

MultiburstAmpdBCh[1..3]Val[1..6]

Returns all six amplitude values (in dB) in burst order.

Returns “---” if no valid measurement currently available.

VARIable:VALue? “MultiburstAmpdBCh2”

Query may return:
“MultiburstAmpdBCh2 –0.09 –0.18 –0.14 –0.13 –0.08 –0.02”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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MultiburstAmpdBCh[1..3]Val[1..6]?

Query the amplitude (in dB) resulting from Multiburst measurement for the
specified channel and value.

VARIable:VALue? “MultiburstAmpdBCh[1..3]Val[1..6]”

Results

None

MultiburstAmpdBCh[1..3]

Returns the specified Multiburst value (in dB).

Returns “---” if no valid measurement is currently available.

VARIable:VALue? “MultiburstAmpdBCh1Val2”

Query may return: “MultiburstAmpdBCh1Val2 -0.26”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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MultiburstAverage < samples >

Set or query the number of samples over which to average the Multiburst
measurement.

VARIable:VALue “MultiburstAverage”, “< samples >”
VARIable:VALue? “MultiburstAverage”

Setup

< samples > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current number of samples for Multiburst measurement.

VARIable:VALue “MultiburstAverage”, “1”
VARIable:VALue? “MultiburstAverage”

Query may return: “MultiburstAverage 8”

Syntax

Group

Arguments

Returns

Examples
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MultiburstFlagmVCh[1..3]?

Query the Flag value (in mV) resulting from Multiburst measurement for the
specified channel.

VARIable:VALue? “MultiburstFlagmVCh[1..3]”

Results

None

Returns the Flag value (in mV).

Returns “---” if no valid measurement currently available.

VARIable:VALue? “MultiburstFlagmVCh3”

Query may return: “MultiburstFlagmVCh3 428.01”

Syntax

Group

Arguments

Returns

Examples
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MultiburstFreqCh[1..3]?

Query all six frequency values (in MHz) resulting from Multiburst measurement
for the specified channel.

VARIable:VALue? “MultiburstFreqCh[1..3]”

Results

None

MultiburstFreqCh[1..3]Val[1..6]

Returns all six frequency values (in MHz) in burst order.

Returns “---” if no valid measurement currently available.

VARIable:VALue? “MultiburstFreqCh1”

Query may return:
“MultiburstFreqCh1 10.00 12.00 14.00 16.00 18.01 20.00”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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MultiburstFreqCh[1..3]Val[1..6]?

Query the frequency (in MHz) resulting from Multiburst measurement for the
specified channel and value.

VARIable:VALue? “MultiburstFreqCh[1..3]Val[1..6]”

Results

None

MultiburstFreqCh[1..3]

Returns the specified Multiburst frequency (in MHz).

Returns “---” if no valid measurement currently available.

VARIable:VALue? “MultiburstFreqCh1Val2”

Query may return: “MultiburstFreqCh1Val2 12.00”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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MultiburstLine < linenumber >

Set or query line number that is to be used for Multiburst measurement.

VARIable:VALue “MultiburstLine”, “< linenumber >”
VARIable:VALue? “MultiburstLine”

Setup

< linenumber > can be an integer or floating point, but will be rounded to the
next lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Multiburst measurement.

VARIable:VALue “MultiburstLine”, “200”
VARIable:VALue? “MultiburstLine”

Query may return: “MultiburstLine 325”

Syntax

Group

Arguments

Returns

Examples
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MultiburstSet < setting >

Set or query whether Multiburst is to be measured upon Execute.

VARIable:VALue “MultiburstSet”, “< setting >”
VARIable:VALue? “MultiburstSet”

Configuration

< setting > specifies whether to perform Multiburst measurement upon
Execute. Valid values are: OFF, ON, 0, 1

Execute
ReportMeasurements

Query returns 0 or 1 depending on whether MultiburstSet measurement is
selected.

VARIable:VALue “MultiburstSet”, “ON”
VARIable:VALue? “MultiburstSet”

Query may return: “MultiburstSet 1”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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NoiseAmpdBCh[1..3]?

Query amplitude value (in dB) resulting from Noise measurement for the
specified channel.

VARIable:VALue? “NoiseAmpdBCh[1..3]”

Results

None

Returns amplitude value (in dB).

Returns “---” if no valid measurement currently available.

VARIable:VALue? “NoiseAmpdBCh2”

Query may return: “NoiseAmpdBCh2 66.43”

Syntax

Group

Arguments

Returns

Examples
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NoiseAmpmVCh[1..3]?

Query amplitude value (in mV) resulting from a Noise measurement for the
specified channel.

VARIable:VALue? “NoiseAmpmVCh[1..3]”

Results

None

Returns amplitude value (in mV).

Returns “------” if no valid measurement is currently available.

VARIable:VALue? “NoiseAmpmVCh2”

Query may return: “NoiseAmpmVCh2 0.33”

Syntax

Group

Arguments

Returns

Examples
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NoiseAverage < samples >

Set or query the number of samples over which to average the Noise measure-
ment.

VARIable:VALue “NoiseAverage”, “< samples >”
VARIable:VALue? “NoiseAverage”

Setup

< samples > Can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current number of samples for Noise measurement.

VARIable:VALue “NoiseAverage”, “1”
VARIable:VALue? “NoiseAverage”

Query may return: “NoiseAverage 8”

Syntax

Group

Arguments

Returns

Examples
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NoiseBW < bandwidth >

Set or query bandwidth of noise filter that is to be used for noise measurement, if
the unweighted noise filter is selected.

VARIable:VALue “NoiseBW”, “< bandwidth >”
VARIable:VALue? “NoiseBW”

Setup

< bandwidth > specifies bandwidth of unweighted noise filter, in Hz. Can be
integer or floating point. Values outside the range will be adjusted to be within
range. Floating point notation is allowed.

NoiseFilter

Query returns the current unweighted noise filter bandwidth, in Hz.

VARIable:VALue “NoiseBW”, “30000000”
VARIable:VALue “NoiseBW”, “3.2E7”
VARIable:VALue? “NoiseBW”

Query may return: “NoiseBW 50000000”

Syntax

Group

Arguments

Related Commands

Returns

Examples



Appendix C: Remote Commands

VM5000HD Automatic Video Measurement Set User Manual C- 39

NoiseFilter < noisefilter >

Set or query type of noise filter that is to be used for noise measurement.

VARIable:VALue “NoiseFilter”, “< noisefilter >”
VARIable:VALue? “NoiseFilter”

Setup

< noisefilter > specifies type of noise filter that is to be used for noise
measurement. Valid noise filters are: Off, Unified, Unweighted.

NoiseBW

Query returns the current specified noise filter.

VARIable:VALue “NoiseFilter”, “Unified”
VARIable:VALue? “NoiseFilter”

Query may return: “NoiseFilter Off”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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NoiseLine < linenumber >

Set or query line number that is to be used for Noise measurement.

VARIable:VALue “NoiseLine”, “< linenumber >”
VARIable:VALue? “NoiseLine”

Setup

< linenumber > Can be integer or floating point, but will be rounded to the
next lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Noise measurement.

VARIable:VALue “NoiseLine”, “200”
VARIable:VALue? “NoiseLine”

Query may return: “NoiseLine 325”

Syntax

Group

Arguments

Returns

Examples
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NoiseSet < setting >

Set or query whether Noise is to be measured upon Execute.

VARIable:VALue “NoiseSet”, “< setting >”
VARIable:VALue? “NoiseSet”

Configuration

< setting > specifies whether to perform Noise measurement upon Execute.
Valid values are: OFF, ON, 0, 1.

Execute
NoiseMeasurements

Query returns 0 or 1 depending on whether NoiseSet measurement is selected

VARIable:VALue “NoiseSet”, “ON”
VARIable:VALue? “NoiseSet”

Query may return: “NoiseSet 1”

Syntax

Group

Arguments

Related Commands

Returns

Examples



Appendix C: Remote Commands

C- 42 VM5000HD Automatic Video Measurement Set User Manual

NonLinearityAverage < samples >

Set or query the number of samples over which to average the Non-Linearity
measurement.

VARIable:VALue “NonLinearityAverage”, “< samples >”
VARIable:VALue? “NonLinearityAverage”

Setup

< samples > Can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current number of samples for Non-Linearity measurement.

VARIable:VALue “NonLinearityAverage”, “1”
VARIable:VALue? “NonLinearityAverage”

Query may return: “NonLinearityAverage 8”

Syntax

Group

Arguments

Returns

Examples
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NonLinearityLine < linenumber >

Set or query line number that is to be used for Non-Linearity measurement.

VARIable:VALue “NonLinearityLine”, “< linenumber >”
VARIable:VALue? “NonLinearityLine”

Setup

< linenumber > Can be integer or floating point, but will be rounded to the
next lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Non-Linearity measurement.

VARIable:VALue “NonLinearityLine”, “200”
VARIable:VALue? “NonLinearityLine”

Query may return: “NonLinearityLine 325”

Syntax

Group

Arguments

Returns

Examples
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NonLinearityPctCh[1..3]?

Query all six non-linearity values (as a percentage) resulting from Non-Linearity
measurement for the specified channel.

VARIable:VALue? “NonLinearityPctCh[1..3]”

Results

None

NonLinearityPctCh[1..3]Max
NonLinearityPctCh[1..3]Val[1..5]

Returns all six non-linearity values (as a percentage) in this order: Maximum
Step1 Step2 Step3 Step4 Step5.

Returns “---” if no valid measurement is currently available

VARIable:VALue? “NonLinearityPctCh3”

Query may return:
“NonLinearityPctCh3 0.82 0.00 0.82 0.69 0.21 0.28”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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NonLinearityPctCh[1..3]Max?

Query the maximum non-linearity value (as a percentage) resulting from a
Non-Linearity measurement for the specified channel.

VARIable:VALue? “NonLinearityPctCh[1..3]Max”

Results

None

NonLinearityPctCh[1..3]
NonLinearityPctCh[1..3]Val[1..5]

Returns maximum non-linearity value (as a percentage) for specified channel.

Returns “---” if no valid measurement currently available.

VARIable:VALue? “NonLinearityPctCh3Max”

Query may return: “NonLinearityPctCh3Max 0.82”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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NonLinearityPctCh[1..3]Val[1..5]?

Query the non-linearity value (as a percentage) resulting from a Non-Linearity
measurement for the specified channel and step.

VARIable:VALue? “NonLinearityPctCh[1..3]Val[1..5]”

Results

None

NonLinearityPctCh[1..3]
NonLinearityPctCh[1..3]Max

Returns non-linearity value (as a percentage) for specified channel and step.

Returns “---” if no valid measurement is currently available.

VARIable:VALue? “NonLinearityPctCh3Val4”

Query may return: “NonLinearityPctCh3Val4 0.21”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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NonLinearitySet < setting >

Set or query whether Non-Linearity is to be measured upon Execute.

VARIable:VALue “NonLinearitySet”, “< setting >”
VARIable:VALue? “NonLinearitySet”

Configuration

< setting > specifies whether to perform Non-Linearity measurement upon
Execute.

Valid values are: OFF, ON, 0, 1.

Query returns 0 or 1 depending on whether NonLinearitySet measurement is
selected.

VARIable:VALue “NonLinearitySet”, “ON”
VARIable:VALue? “NonLinearitySet”

Query may return: “NonLinearitySet 1”

Syntax

Group

Arguments

Returns

Examples
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OPComplete < setting >

OPComplete is set to “1” whenever a VM5000HD GPIB command has been
received and processed and a new command is ready to be processed (except for
the resetting of OPComplete itself, which sets OPComplete to “0”).

OPComplete can only be reset to “0” by the user, and it can only be set to “1”
when a command has been sent and the next command is ready to be input.

OPComplete is designed to control VM5000HD GPIB scripts by ensuring that
the previous command is ready before either (1) querying it’s value or (2) calling
the next command. It should therefore be checked and reset in between each
command, and before querying the new setting.

If a command sets its value to the same value that it is currently set to, OPCom-
plete will not be set to “1”. To avoid this, either set Header to “ON”, or use all
lowercase arguments for text (such as “hd480p60”and “on”), and floating-point
input for numeric values (such as 21.0 instead of 21). This will always cause
OPComplete to be set.

Initialized to “0” on startup.

VARIable:VALue “OPComplete”, “< setting >”
VARIable:VALue? “OPComplete”

Miscellaneous

< setting > -- resets OPComplete so it is ready for the next command.
Valid values are: OFF, 0.

Query returns “1” if a command has been completed since OPComplete was last
reset, otherwise it returns “0”

Syntax

Group

Arguments

Returns
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VARIable:VALue “OPComplete”, “OFF”
VARIable:VALue? “OPComplete”

Query may return: “OPComplete 1”

A typical general-case usage of OPComplete might be:

VARIable:VALue “OPComplete”, “OFF”
// reset first so we know it is set to “0”

VARIable:VALue “Command1”, “Argument1”
// call first command

While ((VARIable:VALue? “OPComplete”) == “0”) (
Wait;

)
// wait till first command is ready before calling next command

// Now repeat the same process for the next command:
VARIable:VALue “OPComplete”, “OFF”

// reset first so we know it is set to “0”
VARIable:VALue “Command2”, “Argument2”
// call next command

While ((VARIable:VALue? “OPComplete”) == “0”) (
Wait;

)
// wait till this command is ready before calling next command
// and so on for subsequent commands

Examples
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RecallSettings < pathstring >

Command recalls settings stored in the specified path/filename.
Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

If you only specify the filename, the default path “c:\VM5000HD” is used. The
file specified in pathstring must have the default extension “.vmset”, or else it
will be appended.

If you get the error message, “Invalid Filename”, confirm that you typed the
correct path and that your path is no more than 60 characters.

VARIable:VALue “RecallSettings”, “< pathstring >”
VARIable:VALue? “RecallSettings”

Settings

<pathstring> specifies the path/filename where the setup file is stored. Can
either be (1) the full path and filename, or (2) just the filename, and the default
path “c:\VM5000HD” will be used. The default extension “.vmset” will be
appended if it is not specified. The pathstring must be less than 60 characters in
length, otherwise the command may not be completed successfully.

SaveSettings

Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

VARIable:VALue “RecallSettings”, “c:\VM5000HD\Tek1.vmset”
VARIable:VALue “RecallSettings”, “Tek2.vmset”
VARIable:VALue? “RecallSettings”

Query may return: “RecallSettings OK”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ReportGenerate < pathstring >

Command generates a measurement report of the specified type (if a measure has
been run and results are available), and saves it in the file specified by pathstring.
The type of file (.rtf, .csv or .pdf) is determined by the file extension in the
pathstring. If the extension does not match one of these endings, a .pdf file is
created by default and “.pdf” is appended to the end of the pathstring.

Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

If you get the error message “Invalid Filename,” confirm that you typed the
correct path and that your path is no more than 60 characters.

VARIable:VALue “ReportGenerate”, “< pathstring >”
VARIable:VALue? “ReportGenerate”

Reports

<pathstring> path/filename where file is to be stored. Can either be (1) the full
path and filename, or (2) just the filename, and the default path “c:\VM5000HD”
will be used. The default extension “.pdf” will be appended if it is not specified.
The specified directory will be created if it doesn’t currently exist. The pathstring
must be less than 60 characters in length, otherwise the command may not be
completed successfully.

ReportString
ReportMeasurements

Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

VARIable:VALue “ReportGenerate”, “J:\netpath\colorbars.csv”
VARIable:VALue “ReportGenerate”, “noise02”
VARIable:VALue? “ReportGenerate”

Query may return: “ReportGenerate OK”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ReportMeasurements < setting >

Set or query the measurements to write to the report when ReportGenerate is
called.

Set to ”All” when application starts.

VARIable:VALue “ReportMeasurements”, “< measuremode>”
VARIable:VALue? “ReportMeasurements”

Reports

< measuremode > specifies the measurements that are to be written to the report
when ReportGenerate is called. Valid measuremode values are All and Selected.
All reports all current valid measurements results, while Selected reports only
those measurements that are currently set.

ChannelDelaySet
ColorBarsSet
MultiburstSet
NoiseSet
NonLinearitySet
ReportGenerate
SyncSet

Query returns the current specified report measurement mode.

VARIable:VALue “ReportMeasurements”, “All”
VARIable:VALue? “ReportMeasurements”

Query may return: “ReportMeasurements Selected”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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ReportString < string >

Set or query user-specified information to write to the report when
ReportGenerate is called.

Initialized to empty string “” on startup.

VARIable:VALue “ReportString”, “< string >”
VARIable:VALue? “ReportString”

Reports

< string > can be up to 46 characters in length. The comma and double quote
characters are not permitted and their usage may result in unexpected program
behavior. All other printable characters are permitted.

ReportGenerate

Query returns the currently specified report string.

VARIable:VALue “ReportString”, “Tested by Joe B - DUT A1”
VARIable:VALue? “ReportString”

Query may return: “ReportString Tested by Joe B - DUT A1”

If assigning consecutive long strings to ReportString, truncation of the second
string may occur if the length of the consecutive strings exceeds a limit (67
characters if Header is ON). For example:

VARiable:VALue ”ReportString”, ”This is a long string which has
45 characters”

VARiable:VALue? ”ReportString”
”ReportString This is a long string which has 45 characters”

VARiable:VALue ”ReportString”, ”This string will be truncated, it
is 45 chars”

VARiable:VALue? ”ReportString”
”ReportString This string will be tr”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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To avoid this truncation, send a short string to ReportString prior to sending the
second string.

VARiable:VALue ”ReportString”, ”This is a long string which has
45 characters”
VARiable:VALue? ”ReportString”

”ReportString This is a long string which has 45 characters”

VARiable:VALue ”ReportString”, ”short”
VARiable:VALue? ”ReportString”

”ReportString short”

VARiable:VALue ”ReportString”, ”This string won’t be truncated,
it is 46 chars”
VARiable:VALue? ”ReportString”

”ReportString This string won’t be truncated, it is 46 chars”
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RunMode < runmode >

Set or query the run mode to use for measurement.

VARIable:VALue “RunMode”, “< runmode >”
VARIable:VALue? “RunMode”

Configuration

< runmode > specifies the run mode that is to be used.
Valid run modes are: Once, Continuously.

Query returns the currently specified run mode.

VARIable:VALue “RunMode”, “Once”
VARIable:VALue? “RunMode”

Query may return: “RunMode Continuously”

Syntax

Group

Arguments

Returns

Examples
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SaveSettings < pathstring >

Command saves current settings in the specified path/filename.
Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

If you only specify the filename, the default path “c:\VM5000HD” is used. The
file will be saved using the default extension “.vmset”.

If you get the error message “Invalid Filename,” confirm that you typed the
correct path and that your path is no more than 60 characters.

VARIable:VALue “SaveSettings”, “< pathstring >”
VARIable:VALue? “SaveSettings”

Settings

<pathstring> specifies the path/filename where the file is to be stored. Can
either be (1) the full path and filename, or (2) just the filename, and the default
path “c:\VM5000HD” will be used. The default extension “.vmset” will be
appended if it is not specified. The specified directory will be created if it doesn’t
currently exist. The pathstring must be less than 60 characters in length,
otherwise the command may not be completed successfully.

RecallSettings

Query returns “OK” unless the command is still being processed, in which case it
returns the current pathstring argument.

VARIable:VALue “SaveSettings”, “c:\VM5000HD\Tek1.vmset”
VARIable:VALue “SaveSettings”, “Tek2.vmset”
VARIable:VALue? “SaveSettings”

Query may return: “SaveSettings OK”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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SetupAndOrRun < setuprunmode >

Set or query the setup run mode to use for measurement.

VARIable:VALue “SetupAndOrRun”, “< setuprunmode >”
VARIable:VALue? “SetupAndOrRun”

Configuration

< setuprunmode > specifies how to perform setup when performing a
measurement. Valid modes are: SetupAndRun, SetupOnly, RunOnly.

Query returns the current specified setuprunmode.

VARIable:VALue “SetupAndOrRun”, “SetupAndRun”
VARIable:VALue? “SetupAndOrRun”

Query may return: “SetupAndOrRun SetupAndRun”

Syntax

Group

Arguments

Returns

Examples
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SyncAverage < samples >

Set or query the number of samples over which to average the Sync measure-
ment.

VARIable:VALue “SyncAverage”, “< samples >”
VARIable:VALue? “SyncAverage”

Setup

<samples > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current number of samples for Sync measurement.

VARIable:VALue “SyncAverage”, “1”
VARIable:VALue? “SyncAverage”

Query may return: “SyncAverage 8”

Syntax

Group

Arguments

Returns

Examples
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SyncLevelsmV?

Query all synchronization levels (in mV) resulting from a Sync measurement.
For Tri-Level Sync, this returns three levels.
For Bi-Level Sync, this returns two levels.

VARIable:VALue? “SyncLevelsmV”

Results

None

SyncLevelsmVVal[1..3]

Returns all synchronization levels (in mV) in this order:
For Tri-Level: FrontPorchLevel NegativeSyncLevel PositiveSyncLevel.
For Bi-Level: FrontPorchLevel SyncLevel.

Returns “---” if no valid measurement currently available.

VARIable:VALue? “SyncLevelsmV”

Query may return: “SyncLevelsmV 0.89 –298.31 299.11”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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SyncLevelsmVVal[1..3]?

Query the specified synchronization level (in mV) resulting from a Sync
measurement.

VARIable:VALue? “SyncLevelsmVVal[1..3]”

Results

None

SyncLevelsmV

Returns specified synchronization level (in mV).

Values must be in the following ranges:
For Tri-Level, 1..3
For Bi-Level, 1..2
Values must designate the following levels:
For Tri-Level: 1-FrontPorchLevel, 2-NegativeSyncLevel, 3-PositiveSyncLevel.
For Bi-Level: 1-FrontPorchLevel, 2-SyncLevel.

Returns “------” if no valid measurement currently available

VARIable:VALue? “SyncLevelsmVVal3”

Query may return: “SyncLevelsmVVal3 299.11”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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SyncLine < linenumber >

Set or query line number that is to be used for Sync measurement.

VARIable:VALue “SyncLine”, “< linenumber >”
VARIable:VALue? “SyncLine”

Setup

< linenumber > can be an integer or floating point, but will be rounded to the
next lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Sync measurement.

VARIable:VALue “SyncLine”, “200”
VARIable:VALue? “SyncLine”

Query may return: “SyncLine 325”

Syntax

Group

Arguments

Returns

Examples
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SyncSet < setting >

Set or query whether Sync is to be measured upon Execute.

VARIable:VALue “SyncSet”, “< setting >”
VARIable:VALue? “SyncSet”

Configuration

< setting > specifies whether to perform Sync measurement upon Execute.
Valid values are: OFF, ON, 0, 1.

Execute
ReportMeasurements

Query returns 0 or 1 depending on whether SyncSet measurement is selected.

VARIable:VALue “SyncSet”, “ON”
VARIable:VALue? “SyncSet”

Query may return: “SyncSet 1”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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SyncTimes?

Query all synchronization times (in nanoseconds) resulting from a Sync
measurement.

For Tri-Level Sync, this returns seven times.
For Bi-Level Sync, this returns five times.

VARIable:VALue? “SyncTimes”

Results

None

SyncTimesVal[1..7]

Returns all synchronization times (in nanoseconds) in the order:
For Tri-Level: FrontPorch NegativeSyncFall NegativeSyncWidth SyncRise
PositiveSyncWidth PositiveSyncFall BackPorch.
For Bi-Level: FrontPorch NegativeSyncFall NegativeSyncWidth SyncRise
BackPorch.

Returns “---” if no valid measurement currently available

VARIable:VALue? “SyncTimes”

Query may return:
“SyncTimes 3822.39 59.03 592.01 52.61 590.40 55.24 1995.19”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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SyncTimesVal[1..7]?

Query the specified synchronization time (in nanoseconds) resulting from Sync
measurement.

VARIable:VALue? “SyncTimesVal[1..7]”

Results

None

SyncTimes

Returns specified synchronization time (in nanoseconds).

Values must be in these ranges:
For Tri-Level 1..7
For Bi-Level 1..5

Values must designate the following times:
For Tri-Level: 1--FrontPorch, 2--NegativeSyncFall, 3--NegativeSyncWidth,
4--SyncRise, 5--PositiveSyncWidth, 6--PositiveSyncFall, 7--BackPorch.
For Bi-Level: 1--FrontPorch, 2--NegativeSyncFall, 3--NegativeSyncWidth,
4--SyncRise, 5--BackPorch.

Returns “---” if no valid measurement currently available.

VARIable:VALue? “SyncTimesVal2”

Query may return: “SyncTimesVal2 59.03”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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Trigger < trigger >

Set or query video trigger to use for measurement.

VARIable:VALue “Trigger”, “< trigger >”
VARIable:VALue? “Trigger”

Configuration

< trigger > specifies trigger that is to be used.
Valid triggers are: Ch1, Ch4.

Query returns the current specified trigger.

VARIable:VALue “Trigger”, “Ch4”
VARIable:VALue? “Trigger”

Query may return: “Trigger Ch4”

Syntax

Group

Arguments

Returns

Examples
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WarningReportingMeasure < setting >

Set or query whether the instrument displays a measurement setup problem
warning dialog on the instrument screen.

VARIable:VALue “WarningReportingMeasure”, “< setting >”
VARIable:VALue? “WarningReportingMeasure”

Configuration

< setting > Valid settings are: OFF, ON, 0, 1.
OFF is the same as 0, and ON is the same as 1.

WarningReportResults
WarningReportSignal

Query returns the current specified setting.

VARIable:VALue “WarningReportingMeasure”, “ON”
VARIable:VALue? “WarningReportingMeasure”

Query may return: “WarningReportingMeasure 0”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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WarningReportingResults < setting >

Set or query whether the instrument displays a measurement results warning
dialog on the instrument screen.

VARIable:VALue “WarningReportingResults”, “< setting >”
VARIable:VALue? “WarningReportingResults”

Configuration

< setting > valid settings are: OFF, 0, ON, 1.
OFF is the same as 0, and ON is the same as 1.

WarningReportingMeasure
WarningReportingSignal

Query returns the current specified setting.

VARIable:VALue “WarningReportingResults”, “ON”
VARIable:VALue? “WarningReportingResults”

Query may return: “WarningReportingResults 0”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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WarningReportingSignal < setting >

Set or query whether the instrument displays an input signal problem warning
dialog on the instrument screen.

VARIable:VALue “WarningReportingSignal”, “< setting >”
VARIable:VALue? “WarningReportingSignal”

Configuration

< setting > valid settings are: OFF, 0, ON, 1.
OFF is the same as 0, and ON is the same as 1.

WarningReportingMeasure
WarningReportingResults

Query returns the current specified setting.

VARIable:VALue “WarningReportingSignal”, “ON”
VARIable:VALue? “WarningReportingSignal”

Query may return: “WarningReportingSignal 0”

Syntax

Group

Arguments

Related Commands

Returns

Examples
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Warning < setting >

Command can be used to reset Warning to “0”. Query returns the most recent
warning reported by the application, or “0” if no warning have occurred since
Warning was last reset. All warnings (Measurement, Signal, and Results) will be
reported.

Initialized to “0” on startup.

VARIable:VALue “Warning” < setting >
VARIable:VALue? “Warning”

Miscellaneous

< setting > resets Warning to 0.
Valid values are: OFF, 0.

Returns the most recent warning reported by the application. Returns “0” if no
warning has occurred since the Warning command was last reset. For a listing of
all possible warnings, refer to Table C--8 on page C--70.

VARIable:VALue “Warning”, “OFF”
VARIable:VALue? “Warning”

Query may return:
“Warning Color Bars: Back Porch Reference Questionable”

Syntax

Group

Arguments

Returns

Examples
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Warning and Error Messages

Tables C--8 and C--9 list the warning and error messages you could see.

Table C- 8: Warning messages

Number Text Possible causes Operation where it may occur

1 Acquisition Problem The instrument cannot trigger or the signal
levels are out of range.

All measurements

2 Channel Delay: Channel <x> & <y>,
Correlation Too Low

You may have the wrong line in the matrix
signal, a distorted signal, or an inappropri-
ate input signal with too few transitions.

Measuring Channel Delay

3 Channel Delay: Disjoint Correlations
Among Channels...

There is a possible group delay mismatch
among channels, or there is an inappropri-
ate signal source.

Measuring Channel Delay

4 Color Bars: <Color> Bar Not Found You may have the wrong line in the matrix
signal, a distorted signal, an incorrect
format selected, channels connected in the
wrong order, the wrong colorimetry, or
excessive cropping of the signal.

Measuring Color Bars

5 Color Bars: Back Porch Reference
Questionable

The signal is distorted. Measuring Color Bars

6 Multiburst: Signal Change: <freq1> -->
<freq2> MHz

You may have low signal levels, an
incorrect signal, or a change in the signal.

Measuring Multiburst

7 Multiburst: Individual Channel Errors:
Channel <x>: Flag <= 0 mV

The signal is distorted or a flag is missing
in the signal.

Measuring Multiburst

8 Multiburst: Individual Channel Errors:
Channel <x>: burst <n>: not detected

You may have low signal levels, distorted
signals, an input signal with less than six
frequency packets, or excessive cropping
of the signal.

Measuring Multiburst

9 Multiburst: Invalid results for all channels You may have the wrong line in the matrix
signal, an inappropriate input signal, or an
incorrect configuration.

Measuring Multiburst

10 Noise: Signal Change: Chan <x> The signal changed during measurement. Measuring Noise

11 Noise: Invalid results for all channels. You may have the wrong line in the matrix
signal, an inappropriate input signal, or an
incorrect configuration.

Measuring Noise

12 Nonlinearity: Invalid Results: Channel <x>:
No ramp or step signal found

You may have the wrong line in the matrix
signal or an inappropriate input signal.

Measuring NonLinearity

13 Nonlinearity: Signal Change: Channel <x>:
...

The signal changed during measurement. Measuring NonLinearity

14 Sync Measurements Inconclusive The instrument could not find a proper
sync, the wrong format was selected, or
the signal is distorted.

Measuring Sync
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Table C- 8: Warning messages (Cont.)

Number Operation where it may occurPossible causesText

15 Sync Measurement: <n> Not Found The instrument could not find a proper
sync.

Measuring Sync

16 Writing over file <filename> The instrument is writing over a file that
previously existed.

Recalling settings;
Generating a report

Table C- 9: Error messages

Number Text Possible causes Operation where it may occur

1 File Name Error: File doesn’t exist:
<filename>

The selected .vmset file doesn’t exist. (You
need to use the full path if the file is not in
the directory C:\VM5000HD.)

Recalling settings

2 Cannot write directory: file already exists:
<filename>

You need to rename <filename> so that
the directory can be written.

Saving settings;
Generating a report

3 File Name Error. Invalid character(s) in file
name

There are invalid characters in the
filename. (Refer to the command structure
description on page C--1. )

Saving settings;
Generating a report

4 No Measurement Selected No measurements are selected in the
Configuration > Measurements menu.

Executing a measure;
Generating a report

5 Cannot create Report. Not all selected
measures have been Run

Need to run a measurement and wait until
it completes before generating a report.

Generating a report

6 Invalid Filename An invalid or non-existing file was used
when performing the operation. Refer to
the command structure description on
page C--1. Also, you need to use the full
path if the file is not in the directory
C:\VM5000HD.

RecallSettings;
SaveSettings;
ReportGenerate (only when
called via GPIB)

7 Invalid Argument An inappropriate argument was used for
the particular GPIB command.

All GPIB commands

8 Command Overflow The GPIB commands were sent in too
rapidly to the instrument. Increase the
delay time between commands to prevent
this problem (recommended 100 millisec-
onds), or use handshaking with OPCom-
plete.

Any time GPIB commands are
sent in too rapidly

9 Command Missed Under certain configurations, a command
can occasionally fail to be processed by
the instrument. This error suggests that a
command sent in the last second may not
have been processed, so you should
return to a recent (known) configuration
and re-send the most recent commands.

Sending a GPIB command
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Appendix D: Cleaning

Use these procedures to clean your instrument. If additional cleaning is required,
have your instrument serviced by qualified service personnel.

Exterior Cleaning

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-
bristle brush. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl
alcohol solution. Use a swab to clean narrow spaces around controls and
connectors. Do not use abrasive compounds on any part of the chassis.

Clean the On/Standby switch using a dampened cleaning towel. Do not spray or
wet the switch directly.

CAUTION. Do not use chemical cleaning agents that might damage the plastics

used in this instrument. Use only deionized water when cleaning the

front-panel buttons. Use a 75% isopropyl alcohol solution as a cleaner and rinse

with deionized water. Before using any other type of cleaner, consult your

Tektronix Service Center or representative.

To prevent getting moisture inside the instrument during external cleaning, use

only enough liquid to dampen the cloth or applicator.

Flat Panel Display Cleaning

The display is soft plastic and must be treated with care during cleaning.

CAUTION. Improper cleaning agents or methods can damage the flat panel

display.

Do not use abrasive cleaners or commercial glass cleaners to clean the display

surface.

Do not spray liquids directly on the display surface.

Do not scrub the display with excessive force.
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Clean the flat panel display surface by gently rubbing the display with a
clean-room wipe (such as Wypall Medium Duty Wipes, #05701, available from
Kimberly-Clark Corporation).

CAUTION. To prevent getting moisture inside the instrument during external

cleaning, use only enough liquid to dampen the cloth or applicator.

If the display is very dirty, moisten the wipe with distilled water or a 75%
isopropyl alcohol solution and gently rub the display surface. Avoid using excess
force or you may damage the plastic display surface.
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Appendix E: Rebuilding the Hard Drive

If you need to rebuild the hard drive, you must install software from three CDs
in the following order:

1. Follow the directions in the CD jewelcase booklet to install the operating
system restore CD, 063-3509-XX.

2. Follow the directions in the CD jewelcase booklet to install the TDS5000
product software CD, 063-3508-XX.

3. Install the VM5000HD application CD, 063-6353-XX.

4. Follow the online instructions.

When asked, enter your option key information from the sticker on the back
of your instrument.
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Appendix F: Signal Source Files (Option SS)

Option SS consists of four CDs and two DVDs that contain Matrix test pattern
signal source files in a number of video formats. See page 2--6 for information
on the Matrix test pattern. Table F--1 lists the Option SS discs.

Table F- 1: Option SS discs

Title Tektronix part number

Baseband Test Signals 063-3660-XX

ATSC Transport Streams 063-3661-XX

Advanced TV Elementary Streams 063-3662-XX

Standard Definition TV Elementary Streams 063-3663-XX

480 Line DVD 063-3664-XX

576 Line DVD 063-3665-XX

Baseband Test Signals CD

The Baseband Test Signals disc (Tektronix part number 063-3660-XX) contains
files for generating baseband test signals. There are two directories:

� The PC directory contains an SXGA sub-directory that contains a 1280 X
1024 bitmap image file, which you can open with MS Paint on a PC and
display the Matrix test pattern at 1280 x 1024 resolution at a 60 Hz
horizontal refresh rate. See page 1--15 for instructions on how to use the
SXGA Matrix bitmap file.

� The TG700 directory contains setup (.dnl) files for generating Matrix test
signals using the Tektronix TG700 TV Signal Generator Platform. Table F--2
lists the available image format standard .dnl setup files.

Table F- 2: Available TG700 DNL signal format files

Image format Field rate TG700 module Color space Signal file name

480p (525 total lines) 59.94 AVG7 RGB 525PSGBR.DNL

YPbPr S525PY.DNL

576p (625 total lines) 50 AVG7 RGB 625PSGBR.DNL

YPbPr S625PY.DNL
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Table F- 2: Available TG700 DNL signal format files (Cont.)

Image format Signal file nameColor spaceTG700 moduleField rate

720p 59.94 AWVG7 RGB 72059PG.DNL

YPbPr 72059PY.DNL

1080i 50 AWVG7 RGB 108050IG.DNL

YPbPr 108050IY.DNL

1080i 59.94 AWVG7 RGB 108059TG.DNL

YPbPr 108059IY.DNL

To use the TG700 .dnl setup files, copy the required file or files to a PC. Then
use the communication program that came with the TG700 to move the setup
files over your network from the PC to the TG700 instrument. Figure F--1 shows
a typical test signal setup using the TG700 instrument as the signal source.

TG700
MPEG

Compression

MPEG
transport
stream

Modulator DUT
RF

Y

Pb

Pr Pr

Y

Pb
VM5000HD

CH3

CH1

CH2TG700 DNL
baseband files

Figure F- 1: Using TG700 baseband test signals
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ATSC Transport Stream CD

The ATSC Transport Streams disc (Tektronix part number 063-3661-XX)
contains files for playout on an MPEG player (such as the Tektronix MTX100
MPEG Recorder and Player) to generate Matrix pattern compressed ATSC
transport stream test signals for 480, 720, and 1080 standards. Table F--3 lists the
available image format standard .trp setup files.

Table F- 3: Available MXT100 .trp signal setup files

Image
format Field rate MTX100 setup file(s)

Associated VM5000HD
setup file

480p 59.94 Tek480pMatrix.trp
Tek480p16x9Matrix.trp

Tek480pMatrix.vmset

720p 59.94 Tek720pMatrix.trp Tek720pMatrix.vmset

1080i 59.94 Tek1080iMatrix.trp Tek1080iMatrix.vmset

The disc also contains some or all of the following:

� Readme files that contain detailed information on each signal setup file. You
should view the readme files before using a signal setup file.

� The .vmset files that you recall into the VM5000HD instrument to configure
the correct default line number values for each measurement. See page 2--16
for instructions on how to recall VM5000HD instruments setups.

NOTE. You must use the associated .vmset file to configure the VM5000HD

before taking measurements from test signals generated using a .trp setup file.

� WFM700 directories that contain .bmp-format screen captures from the
Tektronix WFM700 series Waveform Monitor, showing individual lines and
channels of the Matrix test signal 1 minute video loop, for a particular
format.



Appendix F: Signal Source Files (Option SS)

F- 4 VM5000HD Automatic Video Measurement Set User Manual

To use the MTX100 .trp setup files, insert the disc into the MTX00. Refer to the
MTX100 MPEG Recorder and Player User manual for information on loading
instrument setup files. Figure F--2 shows a typical test signal setup using the
MTX100 instrument as the signal source.

MTX100Transport Stream files on CD

MPEG
transport
stream

VM5000HD

CH3

CH1

CH2DUT
Modulator

RF

Pr

Y

Pb

Figure F- 2: Using ATSC transport stream signals
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Advanced TV Elementary Streams CD
Standard Definition TV Elementary Streams CD

The Advanced TV Elementary Streams disc (Tektronix part number
063-3662-XX) and the The Standard Definition TV Elementary Streams disc
(Tektronix part number 063-3663-XX) contain MPEG2-compressed elementary
stream files. You use these files with a transport stream multiplexor to build
advanced TV or standard definition TV transport streams. Tables F--4 and F--5
list the available elementary stream formats.

Table F- 4: Available Advanced TV Elementary Streams

Image
format Field rate File Ratio

Associated VM5000HD
setup file

480p 59.94 Tek480pMatrix.mpg 4:3 Tek480pMatrix.vmset

Tek480p16x9Matrix.mpg 16:9

720p 59.94 Tek720pMatrix.mpg Tek720pMatrix.vmset

1080i 50 Tek1080i50Matrix.mpg Tek1080iMatrix.vmset

59.94 Tek1080iMatrix.mpg

Table F- 5: Available Standard DefinitionTV Elementary Streams

Image
format Field rate File Ratio

Associated VM5000HD
setup file

480i 59.94 Tek480iMatrix.mpg 4:3 none

Tek480i16x9Matrix.mpg 16:9

576i 59.94 Tek576iMatrix.mpg 4:3 none

Tek576i16x9Matrix.mpg 16:9
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The disc also contains some or all of the following:

� Readme files that contain detailed information on each signal setup file. You
should view the readme files before using a signal setup file.

� The .vmset files that you recall into the VM5000HD instrument to configure
the correct default line number values for each measurement. See page 2--16
for instructions on how to recall VM5000HD instruments setups.

NOTE. You must use the associated .vmset file that is on the same disc to

configure the VM5000HD before taking measurements that use the elementary

stream signals.

To use the elementary stream files, copy the appropriate files into your transport
stream multiplexor. Figure F--3 shows a typical elementary stream test setup.

Transport
Stream

Multiplexor
Elementary Stream

files on CD

MPEG
transport
stream

VM5000HD

CH3

CH1

CH2DUT
Modulator

RF

Pr

Y

Pb

Figure F- 3: Using elementary stream signals
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480 & 576 Line DVDs

The 480 Line DVD (Tektronix part number 063-3664-XX) and 576 Line DVD
(Tektronix part number 063-3665-XX), both generate 60-second Matrix pattern
test signals for use with the VM5000HD instrument. The DVD files are available
in the formats listed in Table F--6.

Table F- 6: Available formats of DVD files

DVD Image format Field rate Program/Track Ratio

480 Line 480i 59.94 1 16:9

2 4:3

576 Line 576i 50 1 16:9

2 4:3

To use the DVD, insert the appropriate DVD into the player, then select the
appropriate program/track for the ratio. Figure F--4 shows the typical setup for
testing DVD players.

DVD
PlayerFiles on DVD VM5000HD

CH3

CH1

CH2
Pr

Y

Pb

Figure F- 4: Using DVD signals

NOTE. The DVD files are in interlace format. The playback device must be set to

progressive mode (480p or 576p) before sending signals to the VM5000HD

instrument.
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Index

Numbers
3--wire composite sync setup, 2--2, 2--3
4--wire with separate sync setup, 2--4
75 Ohm termination, CH4, 2--4

A
Access the Windows desktop, 2--8
Accessories, 1--19

connecting peripherals, 1--7
optional, 1--21
probes, 1--3–1--4
standard, 1--20

Address, Tektronix, xi
Adjusting display contrast, 1--12
Algorhythm descriptions. See Measurements, detailed

information
All button, 2--18, 3--11
Ambient temperature, A--1
Amplitude change, re--do auto scaling, 3--7
App button, 2--8
Application display, default, 2--7
Application software version number, 3--12
Application view area, 2--8
Applications, Microsoft, 1--11
Auto Scale

buttons, 2--12
re--do, 3--7

AutoScale, C--8
Averages, 3--13

interactions with results, 3--8
interactions with Run Mode, 3--8

B
Backing up user files, 1--9
Baseband files, Matrix test pattern, F--1
Buttons

All, 2--18, 3--11
App (restore hidden application), 2--8
Auto Scale On/Off, 2--12
color space type, 2--9
Continuously, 2--12, 3--7
CSV, 2--17, 3--11
Exit, 2--8
Generate Report, 2--18
Hide, 2--8
input signal format, 2--9

instrument On/Standby, 2--7
Once, 2--12, 3--7
Open (load measurement settings), 2--16
PDF, 2--17, 3--11
RTF, 2--17, 3--11
Run, 2--8
Run Mode, 2--12, 3--7
Run Only, 2--11, 3--6
Save (measurement settings), 2--15
Selected, 2--18, 3--11
Setup & Run, 2--11, 3--6
Setup Only, 2--11, 3--6
Stop, 2--8
sync signal trigger channel select, 2--12

C
CD--ROMs, product software, 1--10
Certifications and compliances, A--16
Changing measurement settings, 2--14
Channel Delay measurement, detailed information,

3--14
Channel input and vertical specifications, A--2
ChannelDelayAll?, C--9
ChannelDelayAverage, C--10
ChannelDelayCh1Ch2?, C--11
ChannelDelayCh1Ch3?, C--12
ChannelDelayCh2Ch3?, C--13
ChannelDelayLine, C--14
ChannelDelaySet, C--15
Cleaning

exterior, D--1
flat panel display, D--1

Color Bars measurement, detailed information, 3--16
ColorBarsAverage, C--16
ColorBarsLine, C--17
ColorBarsmVCh[1..3], C--18
ColorBarsmVCh[1..3]Val[1..8], C--19
ColorBarsSet, C--20
ColorSpace, C--21
Commands, C--8

See also Remote commands
Compressed elementary stream files, F--5
Compressed transport stream files, F--3
Configuration commands, C--4
Configuration menu, 3--5
Connecting input signals, 2--2
Connecting peripherals, 1--7
Connecting to a network, 1--11
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Contacting Tektronix, xi
Creating an emergency startup disk, 1--9
CSV, 2--17, 3--11

D
Data storage specifications, A--13
Default application display, 2--7
DefaultSettings, C--22
Description

key features, 1--1
product, 1--1

Desktop, accessing windows, 2--8
Display specifications, A--11
DNL files, Matrix test pattern, F--1
Documentation, related, x
DVD files, Matrix test pattern, F--7
Dynamic range, maximize by autoscaling, 3--7

E
Elementary stream files, Matrix test pattern, F--5
Environment requirements, 1--6
Environmental specifications, A--15
Error, C--23
Error and warning messages, C--70
Execute, C--24
Exit button, 2--8
Exiting the application, 1--11
Exterior cleaning, D--1

F
File menu, 3--3
Files

.vmset, 3--3
Matrix test pattern signal source, F--1
reports, 3--11

Filter settings, 3--8
Firmware, upgrade, 1--3
Flat panel display cleaning, D--1
Format, C--25
Format, input signal, 2--9
Function reference, 3--3

G
Generate Report menu, 3--11
GPIB commands. See Remote commands
GPIB operation, avoiding message box interruptions,

3--7

H
Help, 3--12
Hide button, 2--8
Horizontal and acquisition system specifications, A--7

I
ID?, C--26
Input Matrix test pattern files

for a DVD player, F--7
for MTX100, F--3
for TG700, F--1
for transport stream multiplexor, F--5

Input signal. See Matrix test pattern; Measurements,
detailed information

Input signal connection requirements, 2--1
Input signal format, 2--9
Input signal format view, 2--9
Input signal setups

3--wire composite sync, 2--2, 2--3
4--wire with separate sync, 2--4
PC video card, 2--5

Input/output port specifications, A--12
Installation, 1--5

incoming inspection procedure, 1--13
software installation, 1--10

Installing system software, E--1
Interruptions by message boxes, avoiding, 3--7
Intrepreting results. See Measurements, detailed

information
Introduction, to this manual, ix

K
Key features, 1--1

L
LCD display contrast, 1--12
Line Number, 3--8
Line Number defaults in .vmset file, 3--3
Loading saved measurement setups, 2--16

M
Manuals

part numbers, 1--20
related, x

Matrix signal line numbers, 3--13



Index

VM5000HD Automatic Video Measurement Set User Manual Index- 3

Matrix test pattern
formats, F--1
picture, 2--6

Matrix test signal, matching setup file, 3--3
Measurement settings, changing, 2--14
Measurement setups

recalling, 2--16
saving, 2--15

Measurement steps overview, 2--9
Measurements

detailed information, 3--13
measurements to report, 2--18, 3--11
overview, 3--8
report formats, 2--17, 3--11
reports, 2--17
saving results (reports) to a file, 2--17
selecting, 2--10
setting run--time options, 2--11

Mechanical specifications, A--14
Menu bar, 2--8
Menu descriptions, 3--3
Message boxes, avoiding interruptions, 3--7
Messages, C--70
Minimizing the application and main display, 2--8
Miscellaneous commands, C--4
MTX100 files, Matrix test pattern, F--3
Multiburst measurement, detailed information, 3--17
MultiburstAmpdBCh[1..3], C--27
MultiburstAmpdBCh[1..3]Val[1..6], C--28
MultiburstAverage, C--29
MultiburstFlagmVCh[1..3], C--30
MultiburstFreqCh[1..3], C--31
MultiburstFreqCh[1..3]Val[1..6], C--32
MultiburstLine, C--33
MultiburstSet, C--34
Multiplexor files, Matrix test pattern, F--5

N
Network access, 1--11
Noise measurement, detailed information, 3--19
NoiseAmpdBCh[1..3], C--35
NoiseAmpmVCh[1..3], C--36
NoiseAverage, C--37
NoiseBW, C--38
NoiseFilter, C--39
NoiseLine, C--40
NoiseSet, C--41
Non Linearity measurement, detailed information, 3--20
NonLinearityAverage, C--42
NonLinearityLine, C--43
NonLinearityPctCh[1..3], C--44

NonLinearityPctCh[1..3]Max?, C--45
NonLinearityPctCh[1..3]Val[1..5]?, C--46
NonLinearitySet, C--47

O
On/Standby switch, 1--8
Online help, 3--12
OPComplete, C--48
Open (load measurement settings) button, 2--16
Opening, .vmset files, 3--3
Operating requirements, 1--6
Optimizing for production line testing, auto scale Off,

3--7
Option SS, F--1
Optional accessories, 1--21
Options, 1--19
Out of range, preventing by autoscaling, 3--7

P
PC video card test setup, 2--5
PDF, 2--17, 3--11
Performance verification

functional tests, 1--14
self tests, 1--13

Peripherals, connecting, 1--7
Phone number, Tektronix, xi
Power source specifications, A--14
Powering off, 1--8
Powering on, 1--8
Probes, supported, 1--3
Product

accessories. See Accessories
description, 1--1
models, 1--1
unpacking, 1--5

Product features, 1--1
Product support, contact information, xi

Q
Quitting the application, 1--11

R
Re--do auto scaling, 3--7
Rebuilding the Hard Drive, E--1
Recalling measurement setups, 2--16, 3--3
RecallSettings, C--50
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Reinstalling the system software, E--1
Related documentation, x
Release notes, 1--10
Remote commands, C--1

command descriptions, C--8
startup and exit, C--3

Report generating, menu descriptions, 3--11
ReportGenerate, C--51
Reports, viewing on the MS Windows desktop, 2--8
Reports commands, C--5
ReportString, C--52, C--53
Restore the application when hidden, 2--8
Results appear as dashes, 3--5
Results commands, C--5
Results menu, 3--8
RTF, 2--17, 3--11
Run button, 2--8
Run commands, C--6
Run Mode, 3--6

buttons, 2--12
interactions with Average setting, 3--8

Run Only button, 2--11, 3--6
RunMode, C--55
Running the application, 2--7

S
SaveSettings, C--56
Saving measurement setups, 2--15
Selected button, generating reports, 2--18, 3--11
Selecting measurements, 2--10
Serial, command descriptions, C--8
Service support, contact information, xi
Setting run--time options, 2--11
Settings commands, C--6
Setup & Run button, 2--11, 3--6
Setup commands, C--6
Setup for functional tests, 2--5
Setup Only button, 2--11, 3--6
SetupAndOrRun, C--57
Show the application when hidden, 2--8
Shutdown, 1--8
Signal amplitude change, auto scaling, 3--7
Signal path compensation, 1--14, A--1
Signal sources

matrix files, F--1
non--matrix. See Measurements, detailed information

Site considerations, 1--6
Software, reinstallation, E--1
Software installation, 1--10
Software version number, 3--12
Space requirements, 1--6

Specifications, A--1
certifications and compliances, A--16
channel input and vertical, A--2
data storage , A--13
display, A--11
environmental, A--15
horizontal and acquisition system, A--7
input/output port , A--12
mechanical, A--14
power source, A--14
trigger, A--8
video measurements, A--1

Standard accessories, 1--20
Starting the application, 2--7
Startup disk, creating, 1--9
Stop button, 2--8
SXGA/60 bitmapped file, Matrix test pattern, F--1
Sync measurement, detailed information, 3--21
Sync signal trigger channel buttons, 2--12
SyncAverage, C--58
SyncLevelsmV?, C--59
SyncLevelsmVVal[1..3]?, C--60
SyncLine, C--61
SyncSet, C--62
SyncTimes?, C--63
SyncTimesVal[1..7]?, C--64
Syntax, C--1
System diagnostics menu, 1--13

T
Taking a measurement, 2--13
Taking measurements overview, 2--9
Technical support, contact information, xi
Tektronix, contacting, xi
Termination, 75 Ohm, CH4, 2--4
Test signal. See Matrix test pattern
TG700 DNL files, Matrix test pattern, F--1
Transport stream files, Matrix test pattern, F--3
Trigger, C--65
Trigger specifications, A--8

U
Unhiding hidden application, 2--8
Upgrade, firmware, 1--3
URL, Tektronix, xi
USB devices, 1--7
User files, backing up, 1--9
User interface description, 2--8
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Utilities menu
Generate Report, 3--11
Instrument Calibration, 1--14
Instrument Diagnostics, 1--13

V
Verification, incoming inspection procedure, 1--13
Version number, 3--12
Vertical scale autoscaling, 3--7
Video specifications, A--1
Viewing measurement results, 2--13
Viewing reports on the desktop, 2--8
VMSET files, recalling, 3--3

W
Warning, C--69
Warning and error messages, C--70
Warning message boxes, turn off or on, 3--7
Warning message reporting, 2--12
WarningReportingMeasure, C--66
WarningReportingResults, C--67
WarningReportingSignal, C--68
Web site address, Tektronix, xi
Windows desktop, accessing, 2--8
Windows operating system, backup tool, 1--9
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